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RILSIM LICENSE AGREEMENT
This software is provided without warranty.

PURPOSE
RILSIM has been developed as a service to the international forestry com-
munity. Its purpose is to simplify the fi nancial analysis of reduced-impact 
logging systems in the hope that this will encourage the widespread adop-
tion of logging systems that reduce environmental and social impacts as 
compared to conventional logging systems.

TARGET PLATFORM
The target computing platform for RILSIM is any 32-bit Microsoft® Win-
dows® operating system. Currently this includes Windows 95, 98, Me, NT 
4.0, 2000, XP, 7, and 8. The software should also operate without problems if 
it is installed on Windows Server 2003 or later, but this has not been tested.
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RILSIM’s principle sponsors are the US Agency for International Develop-
ment and the USDA Forest Service, International Programs Offi ce, Asia-
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been provided by Blue Ox Forestry, the Asia-Pacifi c Forestry Commission, 
the Food and Agriculture Organization of the United Nations (Asia-Pacifi c 
Region), the University of Florida, the Center for International Forestry 
Research (CIFOR), and the Tropical Forest Foundation.

RIGHT TO COPY
The RILSIM software, help fi les, example data fi les, and documentation 
fi les may be freely copied and transferred to others without limitation. 
Optimally this should be done by transferring the CD-ROM or the instal-
lation module. If the executable fi le (RILSIM.exe) is transferred then it is 
important also to transfer the documentation fi les (*.pdf, *.rtf, *.txt) and 
the help fi les (*.hlp, *.cnt), which provide detailed information on how to 
use the software. The sample data fi les (*.rdb) should also be copied because 
they may prove helpful to people learning how to use RILSIM.

SOFTWARE COPYRIGHT NOTICE
RILSIM Copyright © 2003-2013 by Dennis P. Dykstra

RILSIM is protected by copyright law in the United States of America and, 
through treaty agreements, in most other countries. However, the software 
and its components (documentation fi les, help fi les, and sample data fi les) 
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may be freely copied and transmitted to other users on condition that they 
are provided without cost except that a modest charge may be assessed to 
cover items such as the following:

• Postage or other shipping and handling costs
• The cost of maintaining a website from which the package may be 

downloaded
• The cost of media such as diskettes or CD-ROM on which the software 

is provided
• The cost of producing a printed User’s Guide or other documentation, 

including translation costs
• The cost of translating the dialog windows and other interactive ele-

ments of the software package into languages other than English

RIGHT TO MODIFY SOURCE CODE
The RILSIM source code is also available and may be modifi ed freely to 
better suit specifi c situations provided that:

1. The modifi ed software is not separately copyrighted.
2. The modifi ed software is not offered for sale (but costs may be recovered 

by assessing a modest charge as provided above).
3. Acknowledgment is provided that the modifi ed software is based on 

RILSIM. Such acknowledgment must appear in any documentation 
provided with the modifi ed software and in the “About” dialog window 
that is accessible from the Help menu.

MODIFICATION OF SOURCE CODE
Information on obtaining the source code and details on how to modify 
RILSIM for special purposes may be obtained from:

Software Development
Blue Ox Forestry
9770 SW Vista Place
Portland, OR 97225-4251, USA
Email RILSIM@blueoxforestry.com

LOCATION OF LICENSE AGREEMENT
This License Agreement may be found in the RILSIM installation folder 
in the fi le License.rtf. The License Agreement must be transferred with 
any copies of RILSIM.

mailto:RILSIM@blueoxforestry.com
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What’s New in RILSIM?
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If you have not used a previous version of RILSIM you will 
probably want to skim this section quickly, then move on to the Intro-
duction. After that you should read Chapter 1 to learn how to install 
RILSIM on your computer. Then read Chapter 2 to become familiar 

with RILSIM’s user interface, and fi nally work through the examples in 
Chapters 3 and 4. After that you may want to return to this section for 
another look.

Previous users of RILSIM should read this section carefully because 
it provides details on the new features that have been incorporated into 
this release of RILSIM. These features are intended to enhance the util-
ity of the software and several of them will probably change the way you 
work with RILSIM. Be sure also to read at least the fi rst part of Chapter 1 
because  it provides information about what you must do before you can 
install the new version of RILSIM on your computer.

New Features in RILSIM 2.0
As a result of a series of workshops that were held during 2003 to introduce 
potential users to RILSIM, a number of suggestions were received about 
possible enhancements that could make the software more useful. Early 
in 2004, the RILSIM Steering Committee decided to support development 
of a new version of the software that would incorporate the suggestions 
considered to be of highest priority. The new features are as follows:

• Database Format. The RIILSIM database format has been changed 
substantially in order to incorporate the new features described below. 
RILSIM 2.0 can read all previous fi le versions and will automatically 
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update them to the latest version. However, previous versions of RILSIM 
cannot read database fi les saved with RILSIM 2.0.

• Units of Measure. Users can now choose between metric units and 
“conventional” units common in the USA and several other countries. 
As an example, logging area can be measured in hectares or in acres.

• Default Units for Logging Area. When an empty database is cre-
ated with the “New” command from RILSIM’s File menu or toolbar, 
by default the new database assumes that the logging area will be 
measured in hectares. Users now have the option of changing this so 
that the default is to measure the area in acres instead. The setting is 
available from the Options menu. Regardless of the default setting, the 
actual unit of measure for area can be changed at any time through a 
drop-down list on the General Data Form.

• Digit-Grouping Symbol. Users can now choose a digit-grouping sym-
bol from a drop-down list on the General Data Form. Digit-grouping 
symbols are commonly used to separate groups of digits within large 
numbers so that the numbers are easier to read. Typically, digits are 
clustered in groups of three. For instance, the number 25836562 is 
easier to read if the digits are grouped as 25,836,562. In this case the 
digit-grouping symbol is a comma. Users can select from among the 
comma, dot, apostrophe, or blank space. Previously the blank space 
was used automatically and could not be changed.

• Depreciation Cost Worksheet. A worksheet has been added that us-
ers can use to calculate depreciation cost directly from within RILSIM. 
The worksheet is optional; if the depreciation cost is already known it 
can be entered directly. The worksheet is opened by clicking a button 
next to the Depreciation data fi eld on the Equipment Data Form.

• Diffi culty Index. Previously only a single Diffi culty Index value could 
be specifi ed that affected all activities in a RILSIM database equally. 
The Diffi culty Index has now been moved to the Activity Data Form, 
and an index value can be specifi ed for each activity individually. The 
index can either be entered directly or a Diffi culty Index Worksheet 
can be opened and used to calculate the index value.

• Activity Chart Printing. Full printing support has been added for 
the Activity Chart. Previously this chart could only be printed as a 
bitmapped image, effectively limiting it to one page at screen resolu-
tion. Multi-page charts can now be printed at the full resolution of the 
user’s printer. Print preview is also supported. The option of printing 
a bit-mapped image continues to be available as well.
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• Tile Windows Vertically. Multiple databases that are open simultane-
ously within a single instance of RILSIM, or multiple views of a single 
database, can now be viewed side-by-side. Previously they could only 
be viewed with one placed above the other (this is still an option). The 
side-by-side format is obtained by selecting “Tile Vertically” from the 
Window menu. The above-and-below format is obtained by selecting 
“Tile Hortizontally” from the Window menu.

• Activity Property Table. Within the Activity Chart, users can now 
view all of the properties associated with an activity by choosing the 
Properties item from the Edit menu or from a context menu opened 
by right-clicking the activity name. A property table will open that 
summarizes all of the properties associated with the activity. This is 
an information-only capability; to edit the properties you have to make 
the changes directly on the Activity Data Form. However, this can now 
be done while the Activity Chart remains open (see the following item 
for details).

• Simultaneous Access to the Activity Chart and the Activity 
Data Form. The Activity Chart and the Activity Data Form can now 
be accessed simultaneously, either tiled vertically or tiled horizontally, 
within the main RILSIM window. As a result, users can make changes 
to activity data while the Activity Chart remains open. To view the two 
windows simultaneously, proceed as follows:

(a) From the Activity Data Form, click the “Activity Chart” button to 
open the Activity Chart.

(b) Maximize the Activity Chart window to provide space so that the 
two windows can be viewed simultanously.

(c) Pull down the Window menu and click the “Tile Vertically” or “Tile 
Horizontally” command. The Activity Chart and the Activity Data 
Form will both be resized and will appear together within the main 
RILSIM window. You can then resize them individually to fi t the 
space better. Clicking an activity name in the Activity Chart will 
cause the Activity Data Form to open the corresponding activity 
record, and you can then make any desired changes directly on the 
Activity Data Form. Remember to click the “Update Data” button 
after making any changes.

(d) When you have fi nished working with the two windows, click the 
“Close” button in the Activity Chart window to close the Activity 
Chart and restore the main window’s size and position.
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• Autosave. An “autosave” feature has been added to the Options menu. 
This feature is off by default. However, once it has been activated you 
can set it to automatically activate every time RILSIM runs. When 
activated, it will automatically save the current database at regular 
intervals that you can specify. Users who have trouble remembering 
to save the database regularly will benefi t from this feature, which can 
help avoid data loss in the event of a power failure.

• Total Revenue. The Scenario Data Form and the formatted simu-
lation report now display total revenue as well as total cost and net 
revenue.

• Blue Numbers for Discounted Values. On the Activity Data Form 
and the Scenario Data Form, discounted costs and revenues are shown 
in blue numbers to distinguish them from compounded amounts, which 
are shown in black numbers.

• Nominal Values and Present Values. Some of the terminology relating 
to costs and revenues has been modifi ed slightly. Previously, discounted 
or compounded values were referred to as “adjusted values.” This term 
is still used occasionally but discounted or compounded amounts are 
also referred to as “present values.” Costs and revenues that have not 
been adjusted to account for the time value of money are referred to 
as “nominal” amounts or occasionally as “unadjusted” amounts.

• Two charts have been added that display results from scenario 
runs to make analysis and comparison easier. Both are opened from 
the Scenario Data Form. The two charts are:

(a) Gantt Chart—Displays the beginning time, ending time, and 
duration of each activity on a graph scaled to the duration of the 
entire project. This type of chart is widely used for project planning 
and control.

(b) Activity-Cost Bar Chart—Summarizes activity costs in the form 
of a horizontal bar chart. By default this chart uses the present 
values of activity costs, but users can change this to nominal values 
if desired. The option to do so is available from the Options menu 
whenever the bar chart is visible.

 A wide range of formatting capabilities is provided for these charts 
through “Page & Print Setup,” which is available from the File menu 
or the toolbar. Full printing support is provided, including the ability 
to print multi-page charts. Print preview is also supported.
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• Unsort Activity List. In formatted simulation reports and in the two 
charts described above, activities can now be listed in their “unsorted” 
order if desired. This is the sequence in which the activities were added 
to the database. The default action is to list the activities in the order 
they would occur during the logging operation. This is referred to as the 
“sorted” order because the activities are sorted by their starting times. 
For some purposes, users may wish to list activities in the unsorted 
order instead. The command to “unsort” the activity list is available from 
the Options menu. Note: This setting does not affect the way activities 
are displayed in the Activity Chart. This is because the purpose of the 
Activity Chart is to graphically portray logical relationships among the 
various activities. Within that chart, therefore, the activities cannot 
be reordered except by changing those logical relationships.

• Pressing the Enter key while the cursor is in a data fi eld now causes 
the input focus to move automatically to the next data fi eld on the form. 
The Enter key can therefore be used as a substitute for the Tab key, 
and some users will fi nd it easier to enter data quickly within the forms. 
Note: This only works with data fi elds. Pressing the Enter key when 
the focus is on a command button will cause the command associated 
with the button to be executed. This action for command buttons is 
required by Microsoft under its user interface guidelines for Windows 
programs.
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RILSIM, the “Reduced-Impact Logging SIM u la tor,” is software 
designed to help you develop discrete-event, deterministic, fi nan-
cial simulation models of logging operations. That’s just a fancy 
way of saying that it enables you to:

• Enter information about an actual or potential logging operation 
into a computer database.

• Use your personal computer to rapidly calculate the fi nancial costs 
and returns that could be expected from the logging operation.

• Print the results in a summary format and as charts that allow you 
to quickly compare alternatives.

• Import the results into spreadsheet or word-processing programs 
so that you can conduct further analyses or prepare reports.

Although the “RIL” in RILSIM is an abbreviation for “Reduced-Impact 
Logging,” RILSIM can in fact simulate any logging operation—low impact, 
high impact, or medium impact—if you can provide suffi cient information 
to fully describe the operation. RILSIM’s overall purpose, though, is to 
provide information that the sponsors hope will encourage the widespread 
adoption of logging methods that reduce environmental impacts; hence the 
emphasis on RIL as part of its name.

What Is Reduced-Impact Logging?
Since the early 1990s, considerable interest has developed in the application 
of reduced-impact logging, especially in tropical forests where damage as-
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sociated with logging has been regarded by many observers as inconsistent 
with sustainable forest management. RIL comprises a set of harvesting 
technologies that have been proven to reduce impacts to residual vegetation, 
soils, and other environmental attributes as compared to “conventional” 
logging technologies.

Conventional logging as widely practiced in tropical forests is character-
ized by little or no advance planning, the use of poorly trained personnel 
operating with improper equipment and tools, and minimal oversight by 
supervisory personnel and government agents. This often results in very 
high rates of soil disturbance and damage to residual vegetation, with 
skidtrails covering as much as 80% of the ground surface, streams dammed 
up by roads built without drainage structures, and 60% or more of future 
crop trees damaged or killed.

There is no fi xed defi nition of what constitutes RIL because the specifi c 
procedures and types of equipment that are appropriate in one situation 
might be inappropriate in a different situation. Nevertheless a RIL opera-
tion in tropical forest typically includes the following:

• Pre-harvest inventory and mapping of individual crop trees.

• Pre-harvest planning of roads, skidtrails, and landings to provide 
access to the harvest area and to the individual trees scheduled for 
harvest while minimizing soil disturbance and protecting streams and 
waterways with appropriate crossings.

• Cutting of vines prior to harvest in areas where large woody vines tend 
to form webs that connect tree crowns.

• The use of controlled felling and bucking techniques, including directional 
felling, cutting stumps low to the ground to avoid waste, and optimal 
crosscutting (bucking) of tree stems into logs to maximize recovery.

• Construction of roads, landings, and skidtrails so that they adhere to 
engineering and environmental design guidelines.

• Winching logs to planned skidtrails and ensuring that skidding ma-
chines remain on the skidtrails at all times.

• Where feasible, utilizing yarding systems that protect soils and residual 
vegetation by suspending logs above the ground.
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• Conducting post-harvest assessments to provide feedback to the timber 
concession holder and the logging crews, and to evaluate the degree to 
which RIL guidelines were applied successfully.

Why Isn’t RIL Used Everywhere?
Most of the practices listed on the preceding page have been developed 
for temperate forests and are commonly used in industrialized countries, 
either because they are required by government regulation or because for-
est managers recognize that such practices save money in the short term 
and also maximize the value of the forest in the longer term. RIL practices 
are also being adopted in some tropical countries, although resistance to 
change remains high. A common explanation for resistance to RIL tech-
nologies in tropical countries is the belief by logging operators and forest 
managers that these technologies will increase logging costs and thus 
reduce short-term profi ts.

In spite of this perception, a number of studies carried out over the past 
two decades have demonstrated that RIL can often reduce total logging 
cost by comparison with conventional logging, even when the longer-term 
economic effects of improved post-harvest forest condition and reduced 
environmental impacts are ignored. These results are often viewed with 
skepticism by loggers in developing countries, however, because the con-
ditions described in the studies seem too different from what the loggers 
encounter on a daily basis.

As a way of overcoming resistance to the adoption of RIL, participants 
in recent conferences on reduced-impact logging have called for simple 
technologies that could help loggers and forest managers do a better job of 
planning their operations and estimating costs and revenues so that they 
can evaluate expected fi nancial and organizational differences between RIL 
and conventional logging. RILSIM is one response to this call.

What Does RILSIM Do?
There is nothing very magical about RILSIM—it simply harnesses the 
power of personal computers to organize information and to make math-
ematical calculations and logical comparisons quickly and effi ciently. The 
basic steps in using RILSIM are as follows:



xx

Introduction

1. Using electronic “data forms” provided by RILSIM, you enter data 
about an actual or potential logging operation into a database. Data 
required for a RILSIM analysis include the following:

• Information about the area to be harvested and general information 
such as the interest rate and currency to be used.

• Information about the personnel who will be assigned to the logging 
operation, how much they will be paid, and the method used to cal-
culate their wages and related costs (time-based wages or piece-rate 
payments).

• Information about the logging equipment to be used and its cost.

2. You then defi ne a set of activities that altogether make up the logging 
operation, and you indicate how these activities relate to each other; 
i.e., which comes fi rst, which next, and so on. You also assign person-
nel and equipment to each activity and estimate the production rate 
associated with the activity.

3. Once these data have been entered, revised as needed, and stored in 
an electronic database from which they can be recalled at any time, 
you launch RILSIM’s simulation engine to make the large number of 
calculations required to compute the beginning and ending times of 
each activity, calculate the production quantity for the activity, and 
determine the total activity cost. The cost is then discounted or com-
pounded using an interest rate, frequency of compounding, and refer-
ence time for interest calculations that you have specifi ed. Optionally, 
the expected revenues from the operation can also be calculated.

4. After an analysis has been run you can print a report to summarize 
the results. You can also save the report in a fi le that can be read into 
a spreadsheet program or word processor. This allows you to include 
the summary in a report or to prepare a comparison chart such as the 
one shown on the opposite page, even though RILSIM does not provide 
this capability directly.

5. After an analysis has been run you can also display on the screen (or 
send to the printer) a bar chart showing the estimated duration of each 
logging activity and how it relates to the other activities; and you can 
similarly produce a bar chart comparing the estimated activity costs.

5. By making several scenario runs with different assumptions you can 
compare expected costs and revenues from conventional logging with 
those that might be anticipated from reduced-impact logging.
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This chart comparing costs of conventional logging and reduced-impact 
logging was prepared with Microsoft Excel, a spreadsheet program, using 
RILSIM results from two scenario runs, one for con ven tional logging and 
one for reduced-impact logging. Data for both runs were taken from the 
report by Holmes et al. (2000).

What Does RILSIM Not Do?
It’s important to recognize that RILSIM is not a “black box” containing 
ready-made data on logging operations. RILSIM is best regarded as a 
specialized type of calculator—like any calculator it knows a lot about 
calculating but very little about the data being used in the calculations. 
RILSIM simply takes information that you provide and very quickly cranks 
out results that would be diffi cult or impossible for you to calculate yourself 
in any reasonable amount of time.

This means, among other things, that you have to be the expert in guiding 
RILSIM’s calculations. You have to defi ne what is meant by conventional 
logging and what is meant by reduced-impact logging. If you can do this, 
you’ll be able to use RILSIM’s ability to very rapidly calculate costs and 
production rates to obtain results that will help you compare the operations 
under whatever local conditions you specify.
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It’s also useful to recognize the boundaries of what RILSIM attempts to 
do. It is a fi nancial simulation modeling system. It cannot estimate the 
amount of soil disturbance or damage to residual vegetation that might 
be expected from a logging operation. As useful as such estimates might 
be, they tend to be very site-specifi c and as a result are diffi cult to imple-
ment in a modeling system intended for application worldwide. RILSIM’s 
designers decided to limit its focus to fi nancial analysis because the need 
for an analytical tool of this type has been recognized, and because the 
principles of fi nancial analysis are the same whether the analysis is being 
done for a tropical rain forest in Brazil, Congo, or Indonesia, or for a larch 
forest in the boreal region of the Russian Far East.

Who are RILSIM’s Intended Users?
Anyone with an interest in reduced-impact logging, or in fi nancial analysis 
of logging operations generally, should fi nd RILSIM useful. Its potential 
users include loggers, forest managers, government foresters and environ-
mental regulators, personnel in development-assistance agencies, university 
students and staff, members of non-governmental organizations, policy 
analysts, and even members of the general public who are concerned about 
issues related to forest management.

The team that designed RILSIM intended it to be relatively simple and 
straightforward in concept, recognizing that the people who need to use 
it are likely to know more about logging operations than about fi nancial 
analysis. It has been designed to run on almost any current-generation 
Windows operating system, including the older and slower ones, in an 
effort to accommodate the relatively modest computing capabilities often 
available in developing countries. Refer to page 2 in Chapter 1 for details 
on RILSIM’s specifi c hardware and operating-system requirements.

This User’s Guide is designed to help you painlessly install the RILSIM 
software on your computer and then quickly become profi cient in using it. 
We hope you fi nd both RILSIM and the User’s Guide useful.
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In recent years the Microsoft® Windows® operating systems have become 
more stable and reliable, but at the same time their complexity has 
increased substantially. One measure of this in crease in complexity 
is the fact that full-scale applications must now be installed through 

a rather complicated technical process if they are to function properly. 
RILSIM is no exception. If you simply copy the executable fi le to your 
hard disk, the software will run but some of its capabilities will be reduced 
and others will not be available at all. This is because the software must 
be properly registered with the computer’s operating system in order to 
achieve full functionality. Thus it is essential that you install RILSIM as 
described in this chapter and by using the installation package provided 
on the CD-ROM or downloaded from the Internet.

Chapter Synopsis

The following pages explain how to install RILSIM on your computer so 
that you can begin using it to develop and run full-scale logging simula-
tion models. If you are already familiar with the process of installing 
software under the current generation of Windows operating systems, 
you’ll probably fi nd little in this chapter that is new to you. Even so you 
might benefi t from a quick look through the chapter before you begin the 
installation process.

Also provided in this chapter is information on how to install Adobe® 
Reader®, a separate application. This software is widely used for publish-
ing documents electronically so it may already have been installed on your 
computer. Otherwise you’ll need to install it if you want to use the online 
version of this User’s Guide.
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System Requirements
RILSIM has been designed to run on a large majority of the personal com-
puter systems that are in common use around the world. In particular, 
considerable effort has been taken to ensure that the software is compat-
ible with the relatively modest computing hardware often available in 
developing countries. 

Nevertheless, RILSIM won’t run on every computer. Before installing the 
software, you should make sure that your computer meets the following 
minimum requirements:

• The computer must run a 32-bit version of the Microsoft Windows 
operating system. This means it must have Windows 95 or later. At 
present this includes Windows 95, 98, Me, NT 4.0, 2000, XP, 7, and 
8. It is likely that RILSIM will also run without problems if installed 
under Windows Server 2003 or later, but this has not been tested.

• If the operating system is Windows NT, then the version must be 4.0. 
In addition, certain of RILSIM’s optional capabilities require NT 4.0 to 
have been upgraded with Service Pack 4 or later. RILSIM’s installation 
program checks this before allowing these options to be selected.

• Your computer system should have at least 40 Mbytes of disk space 
available during the installation process. The software and related fi les 
require a permanent allocation of about 25 Mbytes of disk space.

• Your computer should have at least 24 Mbytes of random-access memory 
and a Pentium-class processor operating at 75 MHz or faster. Systems 
that exceed these requirements will of course operate faster and can 
run larger simulation models.

All of the software needed to run RILSIM is provided as part of the installa-
tion package. However, to use the electronic version of this User’s Guide you 
must also have the Adobe Reader program installed. Installation modules 
for this software are provided on the CD-ROM, and you must install the 
software separately from RILSIM. The installation procedure is described 
on pages 14-15 of this chapter.

In addition, RILSIM’s own capabilities can be extended if you have access 
to a spreadsheet program capable of reading tab-delimited text fi les, but 
this is not a requirement for the installation of RILSIM.
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Options for Installing RILSIM
You have two options for installing RILSIM:

• You can install it from the CD-ROM.

• You can download the installation package from the Internet and use 
it to install the software.

Both methods follow essentially the same procedures, provide identical 
choices, and you end up with the same result. You would normally choose 
the second method only if you don’t have the distribution package. The main 
disadvantage of the second option is that the fi les may take a long time to 
download unless you have a broadband connection to the Internet.

Before You Install RILSIM 2.0
If an earlier version of RILSIM has been installed on your computer, you 
can either remove it before you install version 2.0, or you can allow the 
RILSIM Installer to remove it for you. The RILSIM Installer will auto-
matically remove any earlier version of the software that it fi nds. If you 
prefer to do this yourself, follow the instructions in the section entitled 
“Removing RILSIM” beginning on page 17 of this chapter. Then continue 
with the installation as described below.

Starting the Installation
• If you have the CD-ROM, place it in your computer’s CD or DVD drive 

and close the door. The installation package should launch automati-
cally from the CD-ROM. If it does not, use Windows Explorer to navi-
gate to the root directory of the CD-ROM. Double-click the fi le named 
Setup.exe. This will launch the installation package.

• If you don’t have the CD-ROM, you must fi rst download the installation 
module from the Internet. Direct your browser to the Blue Ox Forestry 
website at

 http://www.blueoxforestry.com/rilsim/

 and follow the instructions. When you download the installation mod-
ule, note its fi lename and the folder on your computer into which you 

http://www.blueoxforestry.com/rilsim/
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download it. Then use Windows Explorer to navigate to the folder and 
double-click the installation module. This will launch the installation 
package.

Important Note: In order to install RILSIM on a computer running Windows 
NT, 2000, or XP you must have administrator privileges. Otherwise 
you will receive a message informing you that RILSIM cannot be installed. 
In that case your system administrator must install the package for you.

Installation Step by Step

Step 1.

After the RILSIM installation package has been launched, an image like 
the one at right will appear briefl y. If your Windows system does not yet 
include the Windows In-
staller program, it will be 
installed automatically 
at this time and a mes-
sage will be displayed. 
Windows Installer is a 
product of Microsoft Cor-
poration. It is a standard 
utility designed for use 
in installing software 
under all versions of 
Windows.

Step 2.

Under some circumstances, RILSIM’s installation software may detect an 
earlier version of RILSIM that it cannot remove from your computer. If 
this happens a message like the one shown below will appear. You must 
then uninstall the older version of RILSIM before you can continue with 

the installation of version 2.0. To do so, 
follow the instructions in the section en-
titled “Removing RILSIM” beginning on 
page 17 of this chapter. After uninstalling 
the earlier version you can then re-start 
the installation process.

Another version of this product is already installed.
Installation of this version cannot continue. To 
confi gure or remove the existing version of this product, 
use Add/Remove Programs on the Control Panel.
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When installation of version 2.0 can continue, the screen shown below will 
appear. Press the Next button to start the installation. If you decide that 
you want to abort the installation, simply click the Cancel button in this 
or any other install a tion window. You will be able to re-start the installa-
tion later at any time you choose.

Step 3.

Read the RILSIM License Agreement. This agreement will be installed as 
part of the RILSIM package so that you can inspect it any time after the 
installation. You must agree to the terms of the license agreement before 
installation can proceed. When you click the radio button labeled “I accept 
the terms in the license agreement,” the Next button will become operable 
and you can click the 
button to continue.
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Step 4.

Next, the RILSIM “Readme” fi le will be presented for your information. 
Like the RILSIM License Agreement, this fi le will also be installed on your 
computer and will be available for your inspection after the installation 
has been completed. The Readme fi le contains the following:

• A brief summary of how to install RILSIM.

• A list of fi les placed on your computer’s hard disk by the installation 
process.

• Information about how to remove RILSIM from your computer.

• A list of items that should be included if you redistribute RILSIM to 
anyone else.

When you press the Next button after you have fi nished with the Readme 
fi le, you’ll either receive a message like the one shown below, or you’ll be 
taken directly to Step 6.

Step 5a.

The message above indicates that an update is available for the “Common 
Controls Library” on your computer. This is a library of software routines 
provided with the Windows operating system for use by programs like 
RILSIM when displaying objects on the computer screen. The message 
should only appear if you are using either Windows 95 or Windows NT 
4.0, or possibly certain versions of Windows 98. If your operating system is 
Windows NT 4.0, the message will also indicate the version of any Service 
Pack (e.g., SP3, SP4, etc.) that may have been installed on your system. 
This information will be used in the following step.

RILSIM Installer has determined that your computer system is 
using an old version of the Microsoft Windows Common Controls 
Library for which an update exists.

Your current library version is 4.0.0.
Your operating system is Windows 95.

Please review carefully the options presented in the dialog 
window that follows and indicate how you would like to proceed.

Click OK to continue.

Please Note:
If a message like the 
one at right does not 
appear, you should 
skip Steps 5a and 
5b and go directly to 
Step 6 on page 8.
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Step 5b.

After you click OK on the message screen above, you will see a window like 
the one below, presenting you with three choices related to the Common 
Controls Library. The discussion below the image outlines these options 
in more detail.

• Install the library update. For most users who receive the message 
on the previous page, this is the recommended course of action. It is 
therefore the default selection. If you press Next the update will be 
installed on your system. Depending on your version of Windows you 
may have to reboot before the installation can continue. In that case 
you may need to restart the installation from Step 1 after you have 
rebooted.

 Important note: If you are running Windows NT 4.0 and the latest 
Service Pack installed on your system is less than SP4 as indicated by 
the window in Step 5a, then you should not install the update. To do 
so you fi rst need to install the latest Service Pack —see the fi nal option 
at the top of the next page for more information about this.

• Do NOT install the update. If you have very little remaining space on 
your computer’s hard disk, then you should choose this option. You 
may also want to choose this option if you are running Windows NT 
4.0 with SP3 or less, or if you simply don’t want any new Windows 
components to be installed on your system with RILSIM. Choosing this 
option will prevent RILSIM from using certain display enhancements 
that have been incorporated into recent versions of Windows, but it 
will not interfere with the operation of RILSIM itself.
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• Exit to install an update. You may prefer to install the updated Common 
Controls Library yourself, rather than letting the RILSIM installer 
do it. You can also choose this option if you are running Windows NT 
4.0 with SP3 or less. You would then need to download the latest NT 
4.0 Service Pack from Microsoft and install it before restarting the 
RILSIM installation. Finally, you can choose this option if you prefer 
to install the latest version of Microsoft Internet Explorer. Doing so 
will automatically update the Common Controls Library.

More information about these options is available by clicking the Help 
button on the window shown in Step 5b on the previous page. If you are 
using the CD-ROM to install RILSIM you can access the same information 
from a fi le named ComCtl32.rtf, which you will fi nd in a folder named \
Redistribute\Comctl32 on the CD-ROM. This is a “rich-text format” 
fi le. A separate Microsoft Word document named “MS Knowledge Base-
Comctl32.doc” is located in the same folder of the CD-ROM. This fi le, from 
Microsoft, briefl y reviews the options related to updating the Common 
Controls Library and Internet Explorer.

After either installing the library update or choosing not to install it, you 
will be taken to Step 6 of the RILSIM installation.

Step 6.

Enter your name and organization as shown in the image below. Default 
values will be placed in these edit fi elds if available from your system. If 
they’re correct you can just click Next to accept them. You will also note 
that a serial number has been automatically generated and is shown in the 
installation dialog. This serial number cannot be changed. It will be associated 

with your copy of RILSIM 
and can be obtained at 
any time from the About 
box available through the 
RILSIM Help menu.
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Step 7.

Decide whether you want a Complete installation or a Custom instal-
lation. The complete installation is normally the better option unless the 
space on your hard disk is extremely limited. Choose one of these options 
and click Next.

Step 7a.

If you selected the Complete installation option you can skip ahead to 
Step 8. Otherwise you will need to make decisions about which features 
of RILSIM you want to install. The features are shown in the image below. 
Only two  —Sample Files and Document Files—are optional. All others 
are either required for the installation or will be installed only if needed. For 
help with this step you 
can press the Help but-
ton. Pressing the Space 
button will give you in-
formation on how much 
space will be required on 
your hard disk for the 
installation options that 
are currently scheduled 
to be installed.
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Step 7b.

If you decide to remove either of the optional features from the installation, 
click the small down arrow to the left of the feature’s label. Then click the 
x option on the popup window as shown here to remove the feature from 
the installation. When you’re satisfi ed with your settings, click Next to 
continue with Step 8.

Step 8.

At this step you can specify the location where RILSIM should be installed. 
The default location is in the Program Files folder of the drive on which 
your Windows system has been installed. To specify a different location 
click the Change button. When you’re satisfi ed, click Next. This will bring 
up a fi nal preparatory window giving you one last chance to go back to a 
previous step or cancel 
the installation. Click 
Next again to fi nalize 
the installation process.
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Step 9.

A window like the one 
at right will report prog-
ress as the installation 
proceeds.

Installation Complete

When the Windows Installer has completed its work a fi nal window similar 
to the one shown below will appear. This is your assurance that a copy of 
RILSIM has been successfully installed on your computer.
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Launching RILSIM
Now that RILSIM has been installed on your computer, how do you use it? 
As with other Windows software, RILSIM is normally launched by clicking 

an icon, which is a small picture associated with an executable fi le. 
The RILSIM icon looks like the image at left. During the instal-
lation, an icon like this will have been placed on your computer’s 
desktop. You can double-click the icon to launch RILSIM. You 

can also remove it if you prefer not to have icons on your desktop. Simply 
click once on the icon and drag it to the recycling bin. Then click again to 
assure Windows that you really do want to remove the icon and not the 
program itself.

An alternative way of launching RILSIM is shown in the illustration below. 
This method uses the Start Programs menu. Click the Start button at the 
lower left of your computer screen, then click Programs or All Programs 
(depending on your version of Windows) in the menu that appears above 
it. Another menu of programs will then pop up, in which you should fi nd 
an item named RILSIM 2.0. Click this item and a submenu will open that 
exposes three items, as shown in the illustration. Clicking on the RILSIM 
item will launch the program.

Note that each of RILSIM’s submenu items is accompanied by a small 
icon. The RILSIM icon in this menu is a smaller version of the desktop 
icon shown above. You’ll also see this smaller icon in Windows Explorer if 
you open the folder in which RILSIM has been installed.

In addition to launching RILSIM itself, you can use the RILSIM 2.0 sub-
menu to launch RILSIM Help. This is a comprehensive online help system 
that is also available from within RILSIM. We’ll have more to say about 
the help system in Chapter 2.

Finally, if you click on the Documentation item of the submenu (as shown 
above) a second submenu will appear with several additional items:

• License – click this item to open the RILSIM License Agreement in 
your word processor.
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• Readme – click to open the RILSIM Readme fi le in your word processor 
so that you can read it.

• Readme (Source) – click to open a Readme fi le with information about 
the programming source code that was used to create RILSIM. Program-
mers can use the source code to modify RILSIM for special purposes, 
such as translating commands and printed text into languages other 
than English.

• User’s Guide – click to load the online version of this User’s Guide into 
the Adobe Reader. If you don’t have the Adobe Reader installed this 
item will be inoperative. To install the Adobe Reader software follow 
the directions in the section entitled “Installing Adobe Reader” begin-
ning on page 14.

First Launch
When you launch RILSIM 
the fi rst thing you will 
see is RILSIM’s “splash 
screen” (right). This win-
dow appears every time 
RILSIM is launched un-
less you dictate otherwise 
by clearing the Splash 
Screen option in RILSIM’s 
View menu. You can close 
the splash screen imme-
diately by clicking the 
mouse button or by pressing Enter. Othewise it will remain visible for 
several seconds and then will close automatically.

After the splash screen closes, the message shown below will appear. This 
will happen only once after you have installed RILSIM. As the message 
indicates, when RILSIM was installed, several sample datafi les were 
placed in a temporary location. You are now given the option of copying 

them to a folder of your own choice. 
The suggested location is a subfolder 
named RILSIM Data\Samples un-
der your “My Documents” folder. This 
is suggested simply because when 
Windows Explorer opens it defaults 
to the “My Documents” folder unless 

When RILSIM was installed on this computer, several sample 
datafi les were placed in an installation folder. You may now 
copy these fi les to a folder of your own choice.

Do you wish to do so?
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you’ve changed the default, and 
thus any subfolders located there 
can be found quickly. If you click 
Yes a message box like the one 
at right will appear. Note that 
this dialog allows you to change 
the location where the fi les will 
be installed if you wish to do so. 
If you click the No button in this 
window, a new dialog will open in which you can point to an existing folder 
on your hard disk. The RILSIM Data\Samples subfolder will then be 
created within this folder and the fi les will be copied there.

After the fi les have been copied, RILSIM’s main window will open. We 
defer a discussion of this until Chapter 2.

Installing Adobe Reader
In order to use the online version of this User’s Guide 
you must have the Adobe Reader program installed on 
your computer. Why would you want to use the online 
version when you already have the printed version, which 

you’re reading right now? For one thing, the online version gives you the 
opportunity to search the entire User’s Guide for a word or phrase. Also, in 
the online version all hyperlinks are active—if you click an Internet link 
your browser will open and the web page pointed to by the hyperlink will be 
loaded. Although the printed version of the User’s Guide is very useful as a 
reference document, it is completely incapable of jumping to a website.

You may already have Adobe Reader installed on your computer. If you’re 
not sure about this, here’s an easy way to check:

1. Open the Start Programs menu.

2. Navigate to the RILSIM 2.0 submenu.

3. Select the Documentation item. This will open a new submenu. See 
the illustration in the lower half of page 12 for an idea of what this 
looks like under Windows XP. It will look somewhat different on other 
versions of Windows, but the general effect will be the same.

4. Within the Documentation submenu, select User’s Guide.

The sample datafi les will be copied to the following folder:
 [My Documents]\RILSIM Data\Samples

This corresponds to the following physical address in your fi le system:
 D:\Documents\RILSIM Data\Samples

Proceed?

Click YES to accept this location, NO to specify a different location, 
or CANCEL if you prefer not to copy the fi les at this time.
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If this launches the Adobe Reader and loads the online User’s Guide so 
that you can read and page through the document, then you’re all set and 
you can skip ahead to page 16.

If, on the other hand, you need to install the Adobe Reader, here is how 
to do it.

• If you are installing RILSIM from the CD-ROM. Adobe Reader is 
provided on the CD-ROM as part of the RILSIM distribution package. 
To fi nd the installation fi le for your computer you need to know which 
version of the Windows operating system you are using. Separate 
installation fi les are provided for Windows 95; Windows 98 and Me; 
and Windows NT, 2000, and XP. You’ll fi nd these on the CD-ROM in 
separate folders that are located under a main folder named Acrobat. 
Open the appropriate folder in Windows Explorer and double-click the 
executable fi le (there is only fi le in each folder). Then follow the prompts 
to install Adobe Reader.

• If you are installing RILSIM from a download. Adobe Reader is not 
included in the downloadable installation package of RILSIM because 
this would increase the size of the download signifi cantly. Therefore, 
if you are installing RILSIM as a download you will need to obtain 
Adobe Reader separately. The installation fi le can be obtained from 
the following website:

 http://get.adobe.com/reader/otherversions/

 You will need to register with Adobe in order to download and install 
the Reader, but the software itself is free of charge.

When you download the software, make a note of its fi lename and the folder 
on your computer into which it is being downloaded. After the download is 
complete, navigate to this folder with Windows Explorer and double-click 
the fi lename. Follow the prompts to install the software.

After Adobe Reader has been installed you can launch it by using the Start 
Programs menu, or you can launch it from Windows Explorer by double-
clicking any Acrobat fi le. The registered fi le extension for an Acrobat fi le 
is .pdf, which is an abbreviation for “portable document format.”

The reason for including Adobe Reader with RILSIM is so that you can use 
it to access the online version of this User’s Guide. To do so, follow steps 
1-4 on the preceding page. The Reader will launch and the opening page 
of the RILSIM User’s Guide will be displayed.

http://get.adobe.com/reader/otherversions/
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Adding Optional Features
When you installed RILSIM you may have chosen not to install either or 
both of the two optional features —the Sample Files and the Documen-
tation Files. If you later decide you need either or both of these features, 
you can use the Windows Add/Remove Programs utility to install them. 
Here’s how.

1. Click the Start button in the lower left corner of your computer 
screen.

2. In the menu that pops up, either click Settings > Control Panel or 
just click Control Panel, depending upon your version of Windows.

3. When the Windows Control Panel appears, launch the Add/Remove 
Programs utility by double-clicking its icon.

4. Navigate to the RILSIM entry in the list of programs and click to high-
light it. Click the Change button if there is one; otherwise click the 
Add/Remove button. In either case the Windows Installer will open 
and you will be presented with a window similar to the one below.

5. Select the Modify option, which is the default. After you click the Next 
button you’ll see the dialog that was shown in Step 7a on page 9 of this 
chapter. Click the down arrow next to the feature you want to install, 
and in the popup window that appears, select the option to install the 
feature on the local hard drive (see Step 7b on page 10). Repeat this 
process for each new feature you want to install. When you’re satisfi ed 
with the options you’ve selected, press Next and the optional feature(s) 
will be installed.
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Repairing RILSIM
If after using RILSIM for awhile you discover that it doesn’t work properly 
or that some of the fi les have unaccountably gone missing, you may need 
to repair the installation. Follow the steps shown on the opposite page but 
in the Program Maintenance dialog select Repair rather than Modify. 
You may be asked to insert the CD-ROM from which the installation was 
launched, or to point to the original installation fi le if you installed RILSIM 
from a download. In the latter case, if you’ve deleted the installation package 
you’ll need to download it again. See the bottom of page 3 in this chapter 
for the website where the package is located.

Reinstalling RILSIM
An alternative way to repair RILSIM is to remove it from your computer 
and then install it again. This is somewhat “cleaner” in that it removes all 
of the Windows Registry entries related to RILSIM and then re-establishes 
them for the new installation. Be sure to follow the instructions below for 
uninstalling RILSIM. Then follow the step-by-step instructions for install-
ing RILSIM as described beginning on page 3 of this chapter.

Removing RILSIM
As wonderful as RILSIM is, not everyone wants it on their computers. You 
may use it for a time and then decide it that doesn’t meet your needs. Or 
you decide to upgrade to a more recent version and need to uninstall the 
older version fi rst. For whatever reason, you’ll fi nd that removing RILSIM 
from your computer is even easier than installing it.

Follow the steps outlined on the opposite page except that in Step 4 you 
should click the Remove button if there is one. Otherwise click Add/Re-
move. Don’t be unnerved by any popup message announcing that Windows 
is starting an “Installation” process. Windows Installer is used not only to 
install RILSIM but also to uninstall it.

In versions of Windows that offer a Remove button within the Add/Remove 
Programs utility, the removal will proceed automatically. Otherwise, a 
window like the one on page 16 will appear. Select the Remove option 
and then click Next.
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After the main components of RILSIM have been removed from your computer 
you may see a message like the one below. Under nearly all circumstances 
your answer to the question posed in this message should be Yes. It’s un-
likely that you would have stored additional fi les in the folder indicated, 
since it is normally used only as a temporary location for installation fi les. 

This message is provided mainly 
as a courtesy. However, you can 
always say No if you aren’t certain 
about this, and check the contents 
of the folder yourself. You may 
need to write down the pathname 
shown in this message so that you 
can navigate to the folder with 
Windows Explorer. The actual 

pathname may be quite different from the one in the message window 
shown here; this varies widely among different versions of Windows. After 
you have navigated to the folder you can move anything you want to keep 
to another location and then delete the folder.

During the removal process the Windows Installer does not remove your 
RILSIM Data folder (see the discussion under the First Launch topic 
on page 13 of this chapter). If you want to remove this folder and the fi les 
in it you must therefore do so yourself.

Removing the installation folder with RILSIM Data Files:

C:\Documents and Settings\All Users\Application Data\RILSIM Data\Samples\

Proceed?

(Normally you should click Yes. The only exception might be if you have saved 
additional data fi les in the folder listed above and have not copied them to 
another location. This is unlikely, since the folder’s only intended use is as a 
temporary storage location for the RILSIM dample data fi les.)
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In spite of the fact that RILSIM is a complex program with a lot going 
on beneath the surface, most of your time working with the software 
will be spent interacting with its “user interface.” In fact, by far the 
greatest part of the programming effort expended in developing RILSIM 

was concerned with the design and functioning of the data forms and other 
interactive objects that altogether form the user interface.

Chapter Synopsis

In this chapter we’ll take a quick tour of RILSIM to give you a general idea 
of the way it functions. The tour places particular emphasis on the user 
interface because of its central importance to you as a user of RILSIM. We 
also examine closely RILSIM’s Online Help system, a key component for 
anyone learning how to use RILSIM effectively.

The best way to follow the tour in this chapter is to launch your own copy 
of RILSIM and compare what you see on the screen with the illustrations 
and descriptions provided here. If you’ve forgotten how to launch RILSIM, 
review the instructions on page 12 of this User’s Guide.
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Splash Screen
As noted in Chapter 1, whenever you launch RILSIM a “splash screen” like the 
one below becomes visible for a few seconds. You can close the splash screen 
immediately by clicking with the mouse button or by pressing the Enter 

key. You can also prevent 
the splash screen from ap-
pearing at all by clearing 
the Splash Screen op-
tion in RILSIM’s View 
menu.

The Main Window
After the splash screen closes, RILSIM’s main window will appear as 
shown on the opposite page. Initially this is just an empty box. The only 
remarkable thing about it is that its background is forest green rather than 
standard “Windows gray.” The components of the window are described 
below and on the opposite page.

• Title bar – Displays the name of the application (RILSIM) and provides 
buttons (at the far right) for minimizing the window, maximizing it, and 
closing the application. There’s also a hidden menu under the RILSIM 
icon; click the icon and the Windows “system” menu will appear.

• Menu bar – Each of the words on this bar (File, View, Options, and 
Help) refers to a menu. You can open the menu by clicking with the 
mouse or by pressing the Alt key, followed by the underlined letter in 
the menu you want to open (e.g., F for File).

• Toolbar – Each icon in this bar represents a shortcut to a menu item. 
The toolbar buttons are provided as a quick way to execute common 
menu commands. By using the toolbar you can execute each command 
with a single click of the mouse. Because a RILSIM database has not 
yet been loaded, only three icons are active in the toolbar shown in the 
image—the two on the extreme left and the one at far right.
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• Window background – This empty green space will eventually be 
fi lled with a set of data forms that you will use to enter and edit data 
for a RILSIM model. Although it’s possible to maximize this window 
or to increase its size by dragging the borders, for most purposes you’ll 
want to leave it at the default size. Each of the data forms has been 
designed to fi t exactly within this space.

• Status bar – Brief messages appear on the left side of this bar. The 
default message (shown above) indicates that you can press the F1 
function key on your keyboard to bring up RILSIM’s Online Help, 
which we’ll explore shortly. Other messages will appear in this space 
from time to time. On the right side of the status bar are three bins 
that show the status of three locking keys on your keyboard. In the 
image above, only one of these keys is shown as being locked in the 
“on” position—the “Number Lock” key. When this indicator is “on,” the 
keypad on the keyboard can be used to enter numeric data. To the left 
of the number lock indicator is a space for the “Caps Lock” key. When 
the word “CAP” appears in this space, all text entered from the key-
board will appear in uppercase letters. At the far right is a bin for the 
“Scroll Lock” key. This key has no function in RILSIM but its indicator 
is included for compatibility with other Windows programs.

Status
Bar

Title
Bar

Menu
Bar

Toolbar

Window
Background
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 Online Help
The developers of RILSIM placed considerable emphasis on the imple-
mentation of a comprehensive online help system—one that you can use 
to get immediate help about any aspect of RILSIM while you work, with-
out having to refer to separate documentation such as this User’s Guide. 
Such help systems are called “online help” because they are available at 
the click of a button or the press of a key. RILSIM Help is not “online” in 
the sense of being stored on the Internet somewhere; it’s located right on 
your own hard disk.

The “help engine” used by RILSIM was developed by Microsoft and is 
provided as part of every Windows operating system. Information used by 
this help engine resides in three fi les on your computer. The fi rst of these, 
RILSIM.cnt, is a “contents” fi le that provides a table of contents for the 
online help topics. The second, RILSIM.hlp, is the help fi le itself, which 
contains all of the help topics that have been prepared for RILSIM. This is 
quite a large fi le—it’s the largest single component of RILSIM, in fact—far 
larger than RILSIM’s executable program fi le. Finally, there’s a third fi le 
named RILSIM.gid. This is an auxiliary fi le used by the Windows Help 
system. It differs from the other two fi les in that it is not installed with 
RILSIM but is created the fi rst time you use RILSIM Help. Also, it can be 
regenerated on demand if it is deleted. All three of these fi les reside in the 
folder where RILSIM was installed on your computer system.

There are four ways to invoke RILSIM Help:

1. From the Start Programs menu. As noted in the section on Launch-
ing RILSIM (page 12), you can start RILSIM Help by clicking on the 
RILSIM Help item in the RILSIM 2.0 sub menu of the Start Programs 
menu. When launched this way it operates as a separate application 
outside of RILSIM.

2. From RILSIM’s own Help menu. You can pull down the Help menu 
by pointing to it with the mouse and clicking the left mouse button, or 
by pressing the Alt key and then pressing H. The menu will display 
three items, as at left.

The underlined letter in each menu item is a 
“shortcut key” that can be used to select the menu 
item from the keyboard (the underlines are only 
visible if you press the Alt key). You can also select 
a menu item by pointing to it with the mouse and 
clicking the left button.

Help

Help Topics
Context Help

About RILSIM...
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 To bring up RILSIM Help from the menu, choose Help Topics. We’ll 
discuss the Context Help item in point 4 below. The About RILISM 
item is only very loosely related to help, but by convention it is always 
located in the Help menu. It opens a window that provides contact 
information for the RILSIM development team and sponsors, and also 
shows the serial number and other information for your copy of RILSIM.

3. The third way to invoke RILSIM Help is by pressing the F1 key on 
your keyboard. This is a standard keyboard shortcut supported by most 
Windows applications. Pressing the F1 key brings up a topic calculated 
to be relevant to the current context; that is, to whatever is currently 
on-screen. We’ll have more to say about this type of help in the F1 Help 
topic on page 27.

4. Finally, you can invoke a special type of RILSIM Help from the toolbar 
or the Help menu. Look back at the image of RILSIM’s main window 
on page 21. On the toolbar, note that one of the three active buttons, 
at the far right of the toolbar, is an arrowhead combined with a ques-
tion mark (see also the image at the end of this paragraph). Clicking 
this button puts RILSIM into a special “context help” mode. You can 
also initiate this type of help by choosing the Context Help item from 
the Help menu. For more information on this type of help refer to the 
Context Help topic beginning on page 26. 

The Help Topics Window

Invoking help with either method 1 or 2 brings up the Help Topics window, 
which appears as in the image below.

The book icons along the left 
side of the window represent 
topic headings. All of these are 
“closed” when the window opens. 
Double-clicking a book reveals 
the individual topics associated 
with that heading. In this image 
the heading “How to Work with 
RILSIM Files” has been opened, 
revealing six topics. Double-
clicking any of these topics will 
cause a new window to open 
and the topic will be displayed. 
The popup window appears as 
shown on page 25.
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Tab Views in the Help Topics Window

Note the three tabs in the Help Topics window on the previous page. You 
can click on a tab to use various capabilities offered by RILSIM Help as 
described below:

• The Contents tab is the active tab in the image on page 23. This pro-
vides an outline view of RILSIM Help, giving you a broad overview and 
a list of some important topics and defi nitions.

• The Index tab lets you look for a word or phrase that you think might 
bring up a topic of interest. Use it the same way you would use the index 
in a book. For instance, if you wanted information about RILSIM’s data 
forms you might look in the index under “data,” “data form,” or “form.” 
Each of these terms is listed in the index along with subsidiary terms 
designed to help you fi nd the information you need.

• The Find tab allows you to search for an individual word or phrase 
anywhere in the entire RILSIM Help system. To use this capability you 
fi rst have to tell Windows Help to construct a searchable database of 
all the topics in RILSIM Help. Then you can type the word or phrase 
you want to fi nd. This is a useful complement to the Index tab because 
not all words and phrases in RILSIM Help appear in the index. For 
instance, if you want to fi nd all occurrences of the word “chainsaw” 
within RILSIM Help, searching on that word with the Find tab will 
list all the topics in which the word occurs. You can then select an 
individual topic to be displayed.

The Popup Help Window

The window in the image on the opposite page is the type that appears 
when you select a specifi c topic in the RILSIM Help system. The labels next 
to the image identify major areas that are discussed below. 

The help window in the image is typical of most. Those with longer topics 
will have scroll bars along the right edge or the bottom that you can use 
to scroll through the text. You can also move the window or resize it to get 
a better view of the topic. You can leave the help window on-screen while 
you’re working with RILSIM.

Menus. Note that the help window has a menu bar. All of the menus and 
associated commands in this window are provided by Microsoft as part of 
Windows Help; they are not part of RILSIM. For the most part they are not 
particularly useful. For example, the Help menu doesn’t actually provide 
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any help—not even on how to use Windows Help! One useful menu item, 
however, is the “Print Topic” command of the File menu (also available 
from the Button row; see below). In addition, the Options menu provides 
several choices that you may fi nd useful, such as the ability to change the 
size of the font used to display help windows.

Buttons. Just below the menu bar in the popup help window is a row of 
buttons. Following is a brief explanation of what each button does.

• The Contents button and Index button operate the same way as the 
equivalent tabs described on the previous page in relation to the Help 
Topics window. There is no Find button in popup help. If you want 
to use the search capabilities of RILSIM Help you must fi rst open the 
Help Contents window by clicking the Contents button.

• The Back button is grayed out in the image above, indicating that it 
is inoperable. This button is used much like the Back button on a web 
browser—it takes you back to the previous topic that you viewed. In 
the image above, the topic being displayed is the fi rst one viewed dur-
ing this session so the tab is inoperable.

• The Print button allows you to print the current topic.

• Finally, there are two “browse” buttons:   and  . These are inoper-
able unless the topic you are viewing has been defi ned as being part of 
a “browse sequence” within RILSIM Help. Whenever the buttons are 
enabled, as in the image above, you can browse forward and backward 
through a sequence of related topics. This is often a useful way to learn 
about RILSIM.

Menus
Buttons

Help Topic Area

Shortcuts
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Help Topic Area. Within the main part of the popup help window is the 
actual help topic itself. Each help topic has a short heading, often with a 
cross-reference in parentheses just to the right of the heading. In the im-
age on the previous page the heading refers to the Open command and 
the cross-reference indicates that the command is available from RILSIM’s 
File menu. Note that the words “File menu” are underlined. They are 
also shown in a different color. This is a code used by Windows Help to 
show that “File menu” is a hyperlink. If you move the mouse pointer over 
the window, it will change from an arrow to a pointing hand whenever it 
encounters a hyperlink. If you then click the mouse button, the help topic 
pointed to by that hyperlink will open in the help window. After reading 
that related topic you can return to the topic you were reading previously 
by pressing the Back button.

In the fi rst line of text describing the Open command in the image on page 
25 you may notice that the words “RILSIM database” are also underlined 
but in this case a dotted underline is used. This indicates that the hyperlink 
points to a brief topic that can be displayed in a small popup window. Such 
items are often defi nitions or short explanations. As with other hyperlinks, 
you open the window by clicking the item with the dotted underline. To 
dismiss the small popup window, click on the window itself.

Shortcuts. The fi nal item shown in the popup help window is a list of 
shortcuts, if any are relevant to the current topic. As shown in the image on 
page 25, the Open command has two shortcuts. One is executed by clicking 
a toolbar button. This is the standard Windows icon for “File Open.” The 
second shortcut may be executed from the keyboard by pressing CTRL+O; 
that is, by holding down the Control key and simultaneously pressing the 
O key. Normally such shortcuts are not case-sensitive; that is, it doesn’t 
matter whether you press O or o; the result will be the same.

Context Help

RILSIM Help also supports a special mode of help that you will undoubtedly 
fi nd useful when learning about the various data forms used to organize 
information for a simulation model. This mode of help is referred to as 
“Context Help.” You can initiate it in either of the following ways:

• Select Context Help from the Help menu.

• Click the Context Help toolbar button. In some of RILSIM’s popup 
windows the Context Help button is located on the window’s title bar, 
since popup windows normally do not have toolbars.
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When context help has been initiated, the mouse cursor will change to 
an arrow and question mark as shown in the fragment of the Wage Data 
Form reproduced below. While it is in this state, clicking on any object in 
the RILSIM window, such as a Toolbar button, a menu item, a data fi eld, 
a button, or an image, will bring up a help window with information about 
the item that was clicked. 

Although Context Help can be initiated with the keyboard through the 
Help menu, you must move the mouse cursor to an object on the data form 
and then click the left mouse button. There is no equivalent keyboard 
procedure for this.

In the illustration shown at right, the user 
has initiated Context Help and is about to 
request a help topic related to the Job Title 
data fi eld of RILSIM’s Wage Data Form.

F1 Help

Like most Windows applications, RILSIM also supports F1 Help, which 
is initiated by pressing the F1 key on the keyboard. F1 Help brings up a 
topic calculated to be relevant to whatever is currently being displayed on 
the screen. It is not as specifi c as the Context Help discussed above, but 
will always open RILSIM Help and display an initial topic from which you 
can move to other topics.

F1 Help is particularly useful when you need a quick explanation about 
the function of a menu item. To obtain such an explanation, pull down the 
menu and move the cursor over the item you’re interested in so that the 
item is highlighted. Without clicking the menu item, press the F1 key. A 
help window will pop up with information about that specifi c menu item. 
This procedure will work in any of RILSIM’s menus.

Tooltips Help
RILSIM provides one fi nal type of help that isn’t strictly part of the online 
help system. This is referred to as “tooltips help.” A tooltip is a small win-
dow that appears when the mouse pointer pauses for a second or more over 
certain objects in a RILSIM data form. The illustration above shows the 
tooltip associated with a command button. Not all objects in the RILSIM 
window produce tooltips; the capability has been activated primarily for 

Open the activity network diagram for this dataset

Activity Chart
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toolbar buttons, form tabs, and command buttons that are located on the 
data forms and worksheets.

RILSIM Data Forms
Now that you know how to use online help, let’s take a look at the data 
forms that you’ll be using to enter and organize data for RILSIM models. 
To create an empty set of data forms, execute the New command. This can 
be done by any of the following means:

• Pull down the File menu and choose New.

• Click the New toolbar button.

• Press CTRL+N.

Any of these commands will bring up a window that looks like the image 
on the opposite page, except that most of the data fi elds in your form will 
be empty. This is because the New command creates an empty database 
except for several items that assume default values.

General Data Form
The data form shown on the opposite page is RILSIM’s General Data 
Form, used for entering some “general” data that affect the way a RILSIM 
analysis will be carried out. This is the form that is initially visible whenever 
you create a new database or open an existing database from a fi le.

We’ll use the General Data Form as an initial example to examine most of 
the features that are available on the data forms.

Online Help for Data Forms

RILSIM’s online help contains full information for each type of data form. 
This can be accessed from the Contents tab of the Help Topics window. 
Double-click the heading entitled “How to Enter Data in RILSIM Data 
Forms” and a list of data forms will be revealed. Double-click any of these 
for information about that data form. You can also look in the online help 
index under “data form,” press the F1 key while the data form is on-screen, 
or use context help for information about any item on the data form.
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Data Form Elements

Note that the menu row now contains a larger number of menus than it 
did before you executed the New command (see the image on page 21 for 
comparison). New menus in the dataform view that you may fi nd particularly 
useful are the Edit menu and the Record menu. Also, the File menu 
and View menu each contain more items now than they did before you 
executed the New command.

The individual menu options are not described here because you can fi nd 
detailed information about them using online help.

Important elements of RILSIM data forms described below. Refer to the 
image of the General Data Form as you read these descriptions.

• Tabs – This row resembles a set of tabbed fi le folders. To switch from 
one data form to another, simply click one of the tabs. You can alterna-
tively pull down the View menu and select the name of the data form 
to which you want to switch.

Tabs

Data
Form

RILSIM
Title

Image

Command ButtonsDrop-Down Lists

Data
Fields
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• Data Form – The physical space occupied by the data form is the same 
for all forms and is bounded on the top by the tab row and on the bot-
tom by the RILSIM title image. Each form includes a photograph, an 
identifying logo and label, and a set of data objects. Unlike spreadsheets 
or word-processing documents, data forms are intended to be used 
at their design size. If you resize a data form, either by clicking the 
“Maximize” button or by dragging the window’s borders, the elements 
of the form will not change; you’ll just have extra empty space.

• Data Fields – These white boxes are used for entering data. They 
may also be referred to as “edit fi elds.” You can type from the keyboard 
directly into a data fi eld and you can also perform many of the same 
editing functions as in a word processor. You can select part or all of 
the data with the mouse cursor and then replace it by typing. When the 
mouse cursor is in a data fi eld, clicking the right button will bring up 
a “context menu” allowing you to perform several editing functions.

 By pressing either the Tab key or the Enter key on the keyboard you 
can move from one data fi eld to the next. Thus you can fi ll out a data 
form entirely from the keyboard without having to use the mouse. Enter 
the data for one data fi eld, press the tab key or enter key, enter data 
for the next fi eld, and so on. The “tab sequence” starts in the upper 
left-hand corner of the data form and proceeds generally toward the 
lower right-hand corner. It is also circular; if you keep pressing the tab 
key you will eventually return to the fi rst data fi eld.

 You can also move directly to a specifi c data fi eld by using the mouse 
cursor. Click within the fi eld to activate it. Click and drag to select all 
or any part of the text already within the fi eld.

 Numeric Data. Some data fi elds accept any kind of text, whereas others 
accept only numeric data. The type of data accepted by each data fi eld 
is usually obvious from the context but is also identifi ed in the online 
help topic for the data fi eld. Numeric data can be entered either as 
integers (whole numbers) or as real numbers, which include a decimal 
point and a decimal fraction (e.g., 3.14). Numeric data fi elds may also 
contain a numeric sign (+ or –). You can use a “digit-grouping symbol” 
to make large numbers easier to read if you wish; the symbol must be 
specifi ed on the General Data Form. RILSIM automatically uses the 
digit-grouping symbol for most numbers larger than one thousand.

 White data fi elds are “editable,” meaning that you can enter and edit 
text or numeric data in them. Gray data fi elds are “protected” and you 
cannot enter data in them (although in most cases you can select the 
data and copy it if you wish). Such fi elds are protected either because 
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the item is not available due to the current setting of an option, or be-
cause the fi eld is used to report a result. There are no protected data 
fi elds on the General Data Form but there are several in the Wage 
Data Forms shown on page 33.

 For detailed information about data fi elds, look up “fi elds” in the online 
help index and click the “data” subtopic.

• Drop-Down Lists – These are data fi elds that provide 
fi xed choices from which you can select. The image at 
right shows one example, the “Frequency of Calculation” 
list for compound interest from the General Data Form. 
The current selection as shown is “Monthly,” indicating 
that interest would be compounded monthly. The user 
is in the process of selecting “Weekly,” so that interest will now be 
compounded on a weekly basis. Other possible selections in the list 
are “Daily” and “Yearly.”

 To open a drop-down list, click the arrow button on the right side of 
the list. You can also tab to the list with the keyboard. Then hold the 
Alt key and press the down arrow key to open the list. Release the 
Alt key and use the arrow keys to select an item. When you tab away 
from the list the current item will remain selected.

• Command Buttons – Buttons are used in RILSIM to execute com-
mands. You can “press” a button by clicking the left mouse button when 
the mouse cursor is hovering over the button, or by pressing the Enter 
key when the button has the input focus. A button receives the input 
focus when you tab to it by using the Tab key on the keyboard.

 For a more detailed discussion of the various types of buttons used in 
RILSIM, look in the online help index under “button.”

 Two buttons are shown on the General Data Form on page 29:

 Update Data Button – This button executes the update data 
command, taking data values that have been entered in the data 
fi elds and incorporating them into the RILSIM database you are 
building. Until this command has been executed, data on the form 
exist only on the form and not within the RILSIM model. Therefore 
it is always essential to execute the update data command after you 
have made any changes to the data on a form. In addition to having 
its own button within the data form’s tab sequence, the update data 
command can also be executed from the toolbar and from the Record 
menu. Hint: Whenever you update data it’s also a good idea to save 
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the fi le to disk with the Save toolbar button or the Save option from 
the File menu. Alternatively you can activate RILSIM’s Autosave 
capability, which we’ll discuss on page 56.

 Cancel Edit Button – This button cancels any changes that have 
been made to the data form since the last time the form’s Update 
Data command was executed. This can be very useful if you change 
some of the data on a form and then realize it was the wrong form or 
the wrong set of data. The cancel edit command can also be executed 
from the toolbar and from the Record menu.

Wage Data Form
The purpose of the Wage Data Form, shown on the opposite page, is to 
help you organize data related to all of the personnel categories relevant 
to the operation that you want to analyze. Two types of wage data can be 
entered:

• Time-based wages, such as hourly wages or monthly salaries. Regard-
less of the actual wage period used, the Wage Data Form calculates an 
hourly cost that will be used in the analysis.

• Piece rates, which are payments based on the quantity of outputs 
produced, such as cubic meters of logs skidded.

The two images on the opposite page show wage data forms with data 
entered for personnel categories compensated by time-based wages (top 
image) and by piece rates (bottom image). For detailed information on the 
data fi elds in the Wage Data Form, check the online help index under “wage 
data form.” Alternatively you can click the context help toolbar button and 
then either click a specifi c data fi eld or, for general information about the 
data form, click the form label (WAGE DATA FORM) near the upper left 
of the form. Or just press the F1 key when the form is being displayed.

Several types of data items appear on the Wage Data Form that were not 
present on the General Data Form examined earlier:

• Record Number Block – This data block includes two protected data 
fi elds. Because they are protected you cannot enter data in them; rather, 
they are used to present information to you. The data fi eld on the left 
reports the record number of the Wage Data Form currently being 
displayed. The data fi eld on the right shows the number of wage data 
records in the database for the simulation model you are developing.
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Wage Data Forms for a time-based wage (top) and for a piece-rate wage 
(bottom). Several data fi elds visible in the top form are missing from the 
bottom form because they are not relevant to piece-rate wages.

Record 
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Type of Wage 
Data Block
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 As this suggests, there can be (and almost always will be) more than 
one wage data record in a RILSIM model. Each record contains data 
for one personnel category. A “record” thus consists of all of the data 
visible on the data form at any one time. To add a new record (i.e., a 
new personnel category) to the database, click the New Record button 
or its equivalent on the toolbar (a large +), or select Add Record from 
the Record menu.

 The set of all records of a particular type (e.g., wage data records) is 
called a dataset. To move among the records in a dataset, use the four 
pointer buttons in the toolbar or select their equivalents from the Record 
menu. For more information look up “toolbar” or “record menu” in the 
online help index.

• Type of Wage Data Block – This data block includes two radio but-
tons, which are buttons that work together to present mutually exclusive 
choices. When one radio button is selected the other is automatically 
cleared. As with other data fi elds you can move to the block of radio 
buttons by using the Tab key on the keyboard. Then, to change the 
selection use the up or down arrow on the keyboard. You can also 
click directly on the button of choice with the left mouse button. See 
“radio button” in the online help index for more information.

• Drop-Down List for Piece-Rate Units – Initially this drop-down list 
is disabled because by default the radio button for time-based wages is 
selected. If you change the selection to piece-rate wages, the drop-down 
list will become enabled. Whenever you select piece-rate wages you 
must also select the production units upon which the piece-rate wages 
will be calculated. In RILSIM models, production can be measured in 
a variety of units that represent log volumes, forest areas, or linear 
measures such as kilometers of road constructed. These choices are 
evident in the drop-down list in the lower image on page 33.

Disappearing Data Fields. Note in the wage data forms on page 33 
that several of the data fi elds visible in the top form are missing from the 
bottom form. This is because those data fi elds, which are used to calculate 
daily and hourly wage costs, are relevant to time-based wages but not to 
piece-rate wages. When the radio button for piece-rate wages is selected 
these data fi eld disappear from the form.

Job Titles. Each wage data record in a RILSIM database must have a 
unique job title, which can be thought of as identifying a personnel category. 
Typical job titles include “Supervisor,” “Laborer,” “Chainsaw Operator,” 
or “Truck Driver.” In some cases you may have two similar personnel 
categories that are compensated differently. For instance, some chainsaw 
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operators might receive hourly wages whereas others could be paid piece 
rates. In order to help you keep track of these, the recommended practice 
is to include a notation in the job title itself for any personnel category 
paid by piece rate. For instance, a chainsaw operator paid an hourly wage 
might have the job title of “Chainsaw Operator,” but one paid a piece rate in 
dollars per cubic meter of logs produced could have the job title “Chainsaw 
Operator ($/m3).” You’ll fi nd that including the piece-rate units in the job 
title will be helpful later when allocating personnel to logging activities 
for the simulation model.

Equipment Data Form
Like the Wage Data Form, the purpose of this form is to help you enter 
and organize cost data. The Equipment Data Form is used to enter data 
on all cost items other than those directly related to personnel. Because 
almost any logging operation you analyze can be expected to have multiple 
items of equipment, the Equipment Data Form supports multiple data 
records. An example of a typical Equipment Data Form is shown on the 
following page.

As shown in the image, the Equipment Data Form includes a number of 
data fi elds that have been provided to help you identify the costs that are 
relevant to each item of equipment. The cost categories are typical of those 
that are commonly used in cost studies of logging operations. They should 
be regarded as suggestions, however, not as obligatory items that have to 
be specifi ed for every piece of equipment. For instance, you can probably 
obtain detailed cost data for a large item of equipment such as a skidder, 
allowing you to enter data in all or most of the suggested cost categories 
on the Equipment Data Form. For smaller items such as a set of instru-
ments used in forest inventories, however, you might not be concerned 
about breaking the cost into categories, and some of the categories would 
not apply anyway. In such cases you can enter the total cost into one of 
the edit fi elds (e.g., “Other Costs”) and leave all of the other data fi elds 
set at zero.

As with the other data forms, until you execute the Update Data command 
any data you have entered on the Equipment Data Form exists only on the 
form and not yet in the RILSIM database. And until you save the datafi le, 
the database exists only in the computer’s memory and not in permanent 
storage on its hard disk.
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For information on any of the cost categories on the Equipment Data Form, 
click the Context Help toolbar button and then click the data fi eld of inter-
est. In the help topic on Depreciation, for instance, you’ll fi nd a discussion of 
what depreciation is and how it can be calculated. For general information 
on the Equipment Data Form itself, click the Context Help toolbar button 
and then click the form label (EQUIPMENT DATA FORM) near the upper 
left of the form. Or just press the F1 key.

RILSIM supports two types of cost data for equipment:

• Time-based costs, which are always computed on an hourly basis 
in RILSIM models.

• Piece-rate costs, based on the same units of production as piece-rate 
wages.

You can switch from time-based cost (the default) to piece-rate cost by 
changing the selection in the “Type of Cost” data block. Unlike the Wage 
Data Form, when you make this change on the Equipment Data Form all 
of the items on the form remain visible. This is because all of the cost cat-
egories are conceptually relevant to both hourly and piece-rate costs—the 
units of measure change but not the cost categories.

Equipment 
Data Form 
showing 
time-based 
costs.

Type of Cost
Data Block

Depreciation
Cost
Worksheet
Button
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Depreciation Cost Worksheet. 
In the image on the previous page, 
notice that adjacent to the Deprecia-
tion data fi eld is an icon that looks 
like a wayward toolbar button. The 
icon is drawn to resemble a spread-
sheet, and it is used in RILSIM to 
represent command buttons that 
will cause specialized worksheets 
to open. This particular button 
is keyed to the Depreciation Cost 
Worksheet. If you click the button, 
a window will open that is designed 
to help you calculate the deprecia-
tion cost for major equipment items. 
This worksheet, shown at right, 
should be relatively self-explanatory 
but pressing the F1 key while the 
worksheet is displayed will bring up 
detailed help about the worksheet 
and its elements.

Equipment Item Name. Each equipment data record in a RILSIM database 
must have a unique equipment item name. Typical equipment item names 
include “Skidder,” “Chainsaw,” “Inventory Tools,” or “Camp Equipment.” 
In some cases you may have two similar equipment items with costs that 
are calculated differently. For instance, a logger might own one skidder and 
also hire a second skidder on a piece-rate basis. As with wages, the recom-
mended practice is to include a notation in the equipment item name for 
any item that has costs based on piece rates. For instance, a skidder with 
hourly costs might have the equipment item name of “Skidder,” whereas 
one with costs calculated as a piece rate in dollars per ton of logs produced 
could be named “Skidder ($/t).” You’ll fi nd that including the piece-rate units 
in the equipment item name will be helpful later when you are allocating 
equipment to logging activities for the simulation model.
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Activity Data Form
Activities are the building blocks that are combined to form a RILSIM model. 
In the RILSIM view of the world, any logging operation can be conceived 
as a set of activities that in combination defi ne the beginning, middle, and 
end of the operation. To take a simple example, a logging operation might 
be composed of three activities named “Tree Spotting,” “Logging,” and 
“Hauling.” The operation might begin with tree spotting and end when the 
last log has been hauled. In between, logging would occur.

Usually it is benefi cial to defi ne a larger set of activities so that the model 
more closely refl ects the details of the real situation on the ground. RILSIM’s 
Activity Data Form is designed to help you defi ne and organize activities 
for any logging operation you want to analyze.

Because there will almost always be more than a single activity in a RILSIM 
model, the Activity Data Form supports multiple records. The set of all 
activity records for a particular model is referred to as the activity dataset 
for that model.

The two images on the opposite page show Activity Data Forms for two 
different types of activities. The form at the top of the page is for a normal 
activity, defi ned as an activity that produces outputs. This includes most 
logging activities. The name of the activity shown in the form is “Skidding,” 
which produces logs skidded to a landing or log deck. Production is measured 
in cubic meters of logs (m3) but it could also have been measured in tons of 
logs (t), in thousands of board feet (Mbf), or any of a variety of other units 
of measure. An example of a somewhat different type of normal activity 
would be tree marking, which “produces” an area of forest (measured in 
hectares or in acres) that has been marked for felling. Costs related to 
normal activities can be expressed on a per-hour basis, a piece-rate basis, 
or as a combination of both hourly and piece-rate costs.

The form at the bottom of the opposite page is for a support activity, 
which does not produce outputs but incurs costs and provides services that 
are necessary for normal activities to continue. The name of the support 
activity on the data form is “Camp Overhead,” which presumably includes 
maintenance of the logging camp and provision of services like cooking and 
washing of clothes. In RILSIM all costs related to support activities must 
be expressed on a per-hour basis only.

For detailed information on any of the data fi elds on the Activity Data 
Form, click the Context Help toolbar button and then click on the data 
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Activity Data Forms for a normal activity (top) and a support activity 
(bottom). Note that several data items in the upper form are missing from 
the lower form because they are not relevant to support activities.
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fi eld or other item of interest. For general information about the Activity 
Data Form itself, click the Context Help toolbar button and then click the 
form label (ACTIVITY DATA FORM) near the upper left of the form, or 
just press the F1 key.

To fully defi ne an activity the following data must be entered:

• Each activity must have a unique activity name.

• The type of activity must be specifi ed (normal activity or support 
activity).

• You must identify any activity that must logically precede the 
activity being defi ned. To do this you select the name of the preced-
ing activity from a drop-down list. The preceding activity must already 
have been defi ned or it won’t appear in the list. For this reason it is 
generally best to enter activities into the database approximately in 
the order they would normally occur in a logging operation. Within the 
drop-down list, the activity names are presented in alphabetical order 
to make it easier for you to fi nd the one you want.

 In the data form shown at the top of the preceding page, the activity 
being defi ned is named “Skidding” and it is shown as being preceded 
by “Felling & Bucking.” Each activity must have exactly one preceding 
activity, or none at all. In every RILSIM model there must also be at 
least one normal activity that has no preceding activity. This is neces-
sary in order to establish a starting point for the simulation. There 
may be more than one such activity.

• You must identify the type of precedence that exists between the activity 
being defi ned and the activity that precedes it. This is also selected from 
a drop-down list. For normal activities the possibilities are as follows:

Type Description

0 The activity has no preceding activity. The activity will therefore 
defi ne the beginning of the simulation.

1 The activity begins when its preceding activity ends. This is 
perhaps the most common relationshiop between activities in 
logging operations.

2 The activity begins when its preceding activity begins. This is 
typical of certain types of logging activities. For instance, landing 
operations typtically begin at the same time as skidding.

3 The activity cannot end until its preceding activity ends.
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 For support activities there are three additional types of precedence. 
These are numbered 4-6 and correspond to types 0-2 in the table except 
that in each case the activity ends only when the fi nal activity in the 
operation ends (i.e., when the logging operation itself ends). This is a 
common situation for support activities.

 For more information look under “type of precedence” in the online 
help index.

• You must enter the number of operating hours per simulation time 
period for the activity. In the illustrations on page 39 this is shown as 
operating hours per week because the simulation time unit was defi ned 
as one week on the General Data Form. Other simulation time units 
supported by RILSIM are days and months. Refer to “simulation time 
unit” in the online help index for a discussion of these options.

• If the activity has a precedence type of 0, you must enter the beginning 
time for the activity. For activities with other precedence types the 
beginning times will be computed by RILSIM’s simulation engine.

• Enter any startup delay expected between the scheduled beginning 
time for the activity and its actual beginning time. Such delays are com-
mon for Type 2 precedence relationships (see the table on the preceding 
page). In such situations there is often a delay between the starting 
time of the preceding activity (e.g., skidding) and the starting time of 
the subsidiary activity (e.g., landing operations). Startup delays can 
also be entered for other precedence types.

• Enter the anticipated production rate for the activity, in units of 
production per operating hour. You must enter a numerical value in 
the data fi eld and also select the production-rate units from the drop-
down list adjacent to the data fi eld.

• If the production-rate units are measured in area units per hour (e.g., 
ha/hr or ac/hr), the “Production/area” data fi eld will be protected and 
its value will be shown as 1.0 ha/ha or 1.0 ac/ac. If the production rate 
is measured in any other units, the data fi eld will become editable and 
you must enter the expected production per unit area for the simu-
lation. For example, if the production rate is measured in m3/hr, then 
you would enter the production/area in m3/ha, as shown in the upper 
Activity Data Form on page 39. For more information see “production 
per area” in the online help index.

• For support activities with precedence types 0, 1, or 2, you must 
also specify the expected ending time of the support activity. Support 
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activities have no production rates and therefore their ending times 
cannot be computed by RILSIM’s simulation engine. Ending times for 
all normal activities are calculated by RILSIM.

• You must assign personnel and equipment to the activity. This 
is done by executing the Personnel and Equipment assignment 
buttons on the data form (see the illustrations on page 39). Each of 
these button brings up a new data form which is associated with the 
activity record currently being defi ned. These subsidiary data forms 
are discussed beginning on page 45.

Diffi culty Index

In the upper image on page 39, one of the data fi elds is labeled “Diffi culty 
Index.” Adjacent to this data fi eld is a worksheet button similar to the one 
for the Depreciation Cost Worksheet discussed on page 37 in connection 
with the Equipment Data Form. The Diffi culty Index data fi eld and its 
associated worksheet button are provided as a means of estimating the 
relative diffi culty of the conditions expected for this activity as compared 
to the same activity if it operated under “average” conditions. A Diffi culty 
Index value of 1.0 implies average conditions; 1.25 implies conditions that 
are 25% more diffi cult than the average; and 0.75 implies conditions that 
are 25% less diffi cult than the average. You can accept the default value 
of 1.0, you can enter a different Diffi culty Index value directly in the data 
fi eld, or you can press the button to open a Diffi culty Index Worksheet de-
signed to help you calculate an index value. We defer a discussion of this 
worksheet until Chapter 3, when it will be introduced in the context of a 
sample problem. For information on the Diffi culty Index and its associated 
worksheet, look in RILSIM’s online help index under “diffi culty index.”

The Activity Chart
The Activity Data Form includes a command button that we haven’t seen 
previously, the Activity Chart button. Executing this button brings up 
a network diagram designed to help you visualize (and revise if necessary) 
the logical relationships among the activities in your simulation model. 
Although the activity chart is accessible from any activity data record, 
it represents all activities in the dataset, not just the activity currently 
being viewed.

When you execute the Activity Chart button, RILSIM sorts the activities 
according to their order of logical precedence and displays them in a pre-
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cedence diagram. This shows how they relate to each other logically. An 
example activity chart is shown below. The text labels in the diagram are 
activity names. One label appears in the diagram for each activity in the 
RILSIM database.

The Activity Chart is different from the data forms we’ve seen previously 
because it isn’t a data form at all but rather a diagram. This is one case 
where you may fi nd it useful to resize the window, for instance if the network 
of activities is too large to fi t into the window at its default size. Scroll bars 
will appear on the right side and along the bottom of the diagram whenever 
it is too large to fi t in the space provided.

In the Activity Chart above,

• All activities are subsidiary to Harvest Unit Layout, which is the 
activity that defi nes the start of the simulation. It has no preceding 
activity and therefore must have Type 0 precedence.

• Inventory, Road Layout, and Vine Cutting are each preceded by 
Harvest Unit Layout. No precedence relationships exist among these 
three activities. They are thus independent and are commonly referred 
to as sibling activities.
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• No activities are shown as being subsidiaries of Vine Cutting.

• Inventory precedes Tree Marking, which in turn precedes Skidtrail 
Layout, which then precedes Felling & Bucking, and so on. The fi -
nal activity in this chain of precedence is Log Transport. Its end will 
defi ne the end of the simulation.

• A parallel chain of precedence is initiated with Road Layout and 
terminates with Landing Construction.

As you can see, the activity chart provides a visual representation of the 
activity dataset in a way that should give you a good understanding of the 
way everything will fi t together in the simulation. It should also let you see 
quickly whether any relationships have been entered incorrectly. Then, if 
you need to fi x problems you can make the following types of corrections 
directly on the activity chart:

• Rename activities.

• Delete an individual activity, or delete an activity together with all of 
its subsidiary activities.

• Select an activity and then insert a new activity, either below the 
selected activity (i.e., as its subsidiary), above it (as its parent), or at 
the same level (as a sibling). New activities inserted on the Activity 
Chart are always given a Type 1 precedence, so if this is incorrect it 
must be changed on the Activity Data Form.

• Move an activity by “drag and drop,” thus redefi ning its logical re-
lationships with other activities. The moved activity retains the type 
of precedence it had before the move, so if this is incorrect it must be 
changed on the Activity Data Form.

• You can view an activity’s Property Table by right-clicking the activity 
name and choosing “Properties” from the popup menu. For information 
about this, look up “property table” in the online help index.

• The Activity Chart can be on-screen at the same time as the Activity 
Data Form in order to facilitate viewing and changing activity data. 
See the topic “editing data, activity chart” in RILSIM’s online help.

In addition to the functions listed above you can also print the activity 
chart, or you can copy it to the Windows clipboard as a bitmapped image 
that can be pasted into another program such as a word processor or im-
age-processing program. For more information about the activity chart and 
its uses, look up “activity chart” in the online help index.
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Personnel and Equipment 
Assignment Data Forms
These two data forms are somewhat different from the other data forms 
because they are always associated with an activity record. You enter 
these data forms by executing the Personnel and Equipment assign-
ment buttons on the Activity Data Form (see page 39). If a personnel or 
activity assignment button refuses to operate, it is because you have not 
yet created a wage dataset or an equipment dataset. This must be done 
before the forms will open; otherwise there are no personnel categories or 
items of equipment to assign.

The purpose of these data forms is to let you assign personnel and equip-
ment, respectively, to the activity currently being displayed in the Activity 
Data Form. At least one person and at least one item of equipment must be 
assigned to every activity in the RILSIM database. Until such assignments 
have been made the simulation engine will refuse to run.

An example Personnel Assignment Data Form is shown below. The Equip-
ment Assignment Data Form is almost identical to this. These forms are 
conceptually rather simple; you fi rst select a personnel category from 
the drop-down list (in the Equipment Assignment Data Form you would 
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select an equipment item category from a similar drop-down list). Then 
you enter into the Number Assigned data fi eld the number of persons 
(or pieces of equipment) from this category that are to be assigned to the 
current activity. When you then click the Update Data button, RILSIM 
will calculate the personnel cost (or equipment cost) associated with the 
assignment and display the result in the protected data fi elds on the right 
side of the data form.

For any activity, you may need to assign workers from more than one per-
sonnel category or equipment from more than one equipment category. For 
instance, an activity named “Felling & Bucking” might have two workers: 
One from a personnel category called “Chainsaw Operator” and another 
from a personnel category called “Felling Assistant.” To accommodate such 
multiple assignments, these data forms support multiple records. Techni-
cally these are referred to as subrecords because they are associated with 
an underlying activity record and the assignment data are stored as part 
of that record. To add a subrecord, use the New Record button or its 
toolbar or menu equivalents. You can then make a personnel or equipment 
assignment for the new subrecord.

Piece-Rate Units

Note on the form on page 45 that a protected data fi eld above the personnel 
category drop-down list indicates the piece-rate units that can be used with 
the current activity. In the form, the units indicated are $/m3 (dollars per 
cubic meter of logs). This information is provided to assist you if you wish to 
make assignments of personnel (or equipment) whose costs are calculated 
from piece rates. The units displayed in this data fi eld are determined by 
the units of production for the activity to which you are currently making 
assignments. For the form shown on the preceding page, the underlying 
activity is “Felling & Bucking” and its production is measured in m3. If 
you select a personnel category (or equipment item category) whose costs 
are calculated from piece rates based on a different unit of production, an 
error message will be generated.

Under some circumstances the entry in this protected data fi eld may be 
“None.” If this occurs, a note will appear below the protected data fi eld 
indicating the reason for this. As one example, the entry in this protected 
data fi eld is always “None” for support activities because only time-based 
costs can be used with support activities. For more information look up 
“piece-rate units” in the online help index.
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Return Button

When you have fi nished making assignments to the current activity, execute 
the Return button at the bottom right of the form to return to the Activity 
Data Form. Even though the Personnel Assignment and Equipment As-
signment Data Forms appear when open as tabbed data forms, you cannot 
click the tabs to close either of these forms. This is because each is really a 
subform associated with a specifi c activity data record. You must therefore 
execute the Return button in order to return to that activity record.

For more information about these data forms, look in the online help index 
under “personnel assignment data form” and “equipment assignment data 
form.”

Scenario Data Form
This is RILSIM’s fi nal data form. The purpose of this form is to enable you 
to enter data that defi ne the type of simulation analysis to be run, and 
then to launch the actual simulation. Two types of simulation analyses 
are supported: Cost analysis and net revenue analysis.

The images on the following page show two views of a sample Scenario Data 
Form for a cost-only analysis. The upper image shows the form during the 
simulation run (note the “progress bar” that has appeared in the status bar 
at the bottom of the window to show the progress of the simulation). The 
lower image shows the form after the simulation has been completed and 
some of the protected data fi elds have been fi lled in with results.

To execute a cost-only analysis you proceed as follows:

• Enter a scenario description.

• Enter the time period (in simulation time units as specifi ed on the 
General Data Form) that should be used as the reference time for 
compounding and discounting calculations, or choose an activity 
whose beginning time should be used as this reference time.

• Execute the Update Data button to incorporate these entries into 
the RILSIM database. It’s also a good idea to save the data fi le to disk 
before running a scenario.

• Execute the Run Scenario button to launch the simulation.
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Two views of a Scenario Data Form for a cost-only analysis. The upper 
image shows the form during a simulation run and the lower image shows 
the same form after the simulation run has been completed.
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A typical simulation run requires only a fraction of a second; in the lower 
image on the preceding page the calculation time has been reported as 
less than 0.001 seconds. Note also that the total projected operating time 
is listed as slightly more than 41.5 weeks for this simulation.

After the simulation run has been completed, the Total Cost data fi elds are 
updated with both nominal and compounded or discounted cost informa-
tion. In the lower image on the opposite page the total cost is a discounted 
cost because the reference time for interest calculations was entered as 
time 0, the beginning of the simulation. The quantity in the “Compounded 
or Discounted” column is shown in blue numbers, rather than the black 
numbers that are used for compounded costs.

Following a simulation run you can return to the Activity Data Form and 
move through the activity dataset record by record. You’ll note that the 
beginning and ending times, the production quantity, and the total activity 
costs have now been fi lled in for each activity.

You can also print a formatted report that summarizes the simulation 
results by pulling down the File menu and choosing the Print Report 
command. If you don’t want to actually send the report to the printer you 
can either save it as a tab-delimited text fi le by choosing the Save Report 
As command, or you can use the Print Preview command to view the 
report on-screen. For more information about each of these commands pull 
down the File menu, highlight a menu command, and press the F1 key on 
the keyboard to bring up a help topic about that command.

Net Revenue Analysis

In addition to the cost-only analysis, RILSIM can also calculate revenues 
from log production. The image on the next page shows the Scenario Data 
Form after such an analysis has been run. If you compare this form with 
the forms on page 48 you’ll note the following differences:

•  The check box labeled “Calculate Net Revenue” has been checked. 
Checking this box enables two data items within the associated data 
block. The fi rst of these is a drop-down list containing the activity 
names for the current analysis. One activity must be designated as 
the revenue-producing activity. In the form shown on page 50, the 
activity named “Log Deck Operations” has been selected.

• The second data item enabled within the net revenue data block is the 
expected log price to be used in calculating revenues. The price must 
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be expressed in units that are consistent with the units of production 
for the designated revenue-producing activity. In the image above these 
units are $/m3 (dollars per cubic meter of logs). Because only a single 
log price can be entered you must calculate (outside of RILSIM) an 
average log price based on the expected mix of species and log grades 
for the operation. This average log price should then be entered in the 
data fi eld.

• Also note that the designation of a reference time for compounding 
and discounting has been specifi ed differently in the image above 
than in the data forms on page 48. Rather than specifying a simula-
tion time period, here the reference time has been designated as the 
beginning of the activity named “Log Deck Operations.” We don’t know 
in advance when this time will occur because it has to be calculated 
during the simulation. RILSIM will do this for us.

• It may surprise you to note that although the nominal total cost 
($13,323.70) is the same in the image above as in the lower image on 
page 48, the form above shows a total cost of $13,956.44 in the “Com-
pounded or Discounted” column whereas the form on page 48 shows a 
total cost of $11,356.35 in that column. Why are these different? The 
answer lies in the reference time for compounding and discounting, 
and the fact that a relatively high rate of interest (27.4% annual rate, 
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compounded monthly) was used in this analysis. In the simulation 
run shown on page 48 the reference time for interest calculations 
was period 0, the beginning of the simulation. In the form on page 50, 
the reference time is the beginning of the activity named “Log Deck 
Operations,” which turns out to be 39.57 weeks after the beginning of 
the simulation. This is only two weeks before the end of the simulated 
operation so most costs occur before this time period; hence they are 
compounded forward to the reference time rather than being discounted 
back to it as in the simulation on page 48.

• The Scenario Data Form on the preceding page also shows the nominal 
and discounted total revenues and net revenues from the operation. Total 
revenue is calculated by multiplying the log price by the total volume 
of logs harvested. Net revenue is calculated by subtracting total cost 
from total revenue. For this example, all revenues are received after the 
reference time period for interest calculations, so they are discounted 
back to that point; thus the net revenue in the “Compounded or Dis-
counted” column is less than the amount in the “Nominal” column.

As with the cost-only analysis, when you have completed a net revenue 
analysis you can print a formatted report, view it on-screen with the print 
preview command, or save it as a tab-delimited text fi le.

You can also view the results of the simulation in two charts, a Gantt Chart 
and a Bar Chart. These are accessible from the buttons with those names 
on the Scenario Data Form. Rather than discuss the charts here we’ll defer 
this topic until Chapter 3, when we can discuss them in the context of an 
actual simulation analysis. If you’re anxious to learn about them now, look 
up “charts” in the online help index or skip ahead to page 77.

End of the Tour
We’ve now completed the “grand tour” of RILSIM’s online help system 
and the user interface with which you interact in developing and run-
ning a RILSIM model. In the remainder of this chapter we cover several 
additional topics that are also related to the user interface but didn’t fi t 
neatly into the tour.
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Record Sorting
In the Wage Data Form and the Equipment Data Form, records are au-
tomatically sorted in alphabetical order by job title and equipment item 
name, respectively. This is intended to make it easier for you to quickly 
fi nd the record you need. However, it also means that the record number 
associated with a particular job title or equipment item name may change 
as new records are added to the dataset.

When a RILSIM document is opened, data records are read from the fi le 
and automatically sorted if necessary, according to the rules listed below. 
Wage data records and Equipment data records are also sorted whenever 
those datasets are changed; i.e., when a record is deleted, a new record is 
added, or any changes are made to the data fi elds upon which sorting is 
based.

• Wage data records – sorted in alphabetical order by Job Title.

• Equipment data records – sorted in alphabetical order by Equipment 
Item Name.

• Activity data records – not sorted. This is because activities are nor-
mally entered into a RILSIM database in the order they would occur 
in the logging operation. They are maintained in this order because 
it seems more natural for a user to look for them in sequence rather 
than alphabetically. However, whenever activity names appear in 
drop-down lists the names are sorted alphabetically to make it easier 
to quickly locate a particular activity. Also, when activities are listed 
in a formatted simulation report or chart after a scenario run they are 
shown in the order they would occur during the logging operation. If 
you wish, you can instead list them in the sequence they were entered 
into the RILSIM database. To do so, choose “Unsort Activity List” from 
the Options menu.

• Personnel Assignment data records – not sorted. These are sub-
records that are tied to individual activity data records.

• Equipment Assignment data records – not sorted. These are also 
subrecords that are tied to individual activity data records.

The remaining two datasets, the General dataset and the Scenario 
dataset, are not sorted because there is always exactly one record in each 
dataset.
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Record-Level Editing
The three main data forms that accommodate multiple records (the Wage 
Data Form, Equipment Data Form, and Activity Data Form) provide 
several record-level editing capabilities that you may fi nd useful. These can 
be executed either from the toolbar or from the Edit menu. In the online 
help index look up “toolbar” and “edit menu” for detailed information.

• Cut Record – Delete the record currently being displayed. This re-
moves the record from the database and transfers all of its data to the 
Windows clipboard. The two subrecord forms (Personnel Assignment 
and Equipment Assignment data forms) also support this command 
but do not transfer the data to the clipboard. For more information see 
“cut record” in the online help index.

• Copy Record – Copy all of the data in with the record currently being 
displayed to the Windows clipboard, but do not delete the record. For 
more information see “copy record” in the online help index.

• Paste Record – Add a new record to the database and paste the data 
from the most recent cut record or copy record operation into the 
new record. The paste command is only available when the clipboard 
contains data appropriate for the type of data form currently being 
displayed. For more information see “paste record” in the online help 
index.

•  Undo – Reverse the last cut record operation. This command is only 
available until the clipboard is overwritten with data from another cut 
or copy operation. Multiple levels of undo are not supported. For more 
information see “undo” in the online help index.

 To undo a paste record operation, simply delete the record.

Currency Units
RILSIM’s General Data Form provides two data fi elds that allow you to 
designate the currency used in an analysis. One data fi eld allows you to 
specify a currency name up to 15 characters in length, and the other fi eld 
allows you to enter a currency symbol up to 5 characters in length.

Examples of currency names include US dollar, Euro, Rupiah, Swiss franc, 
pound Sterling, and many others. Examples of currency symbols include 
$, €, Rp., SFr., and £.
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The currency name and symbol are used in RILSIM reports to identify the 
currency used for the analysis. These data values are saved with the RILSIM 
database and the same currency name will be used each time the database 
is opened unless you change the name and then re-save the database.

When an empty RILSIM database is created by using the File menu’s 
New command, the currency name and currency symbol data fi elds will 
be initialized with the default name and symbol for the Windows system 
on which RILSIM is being used. These depend upon the specifi c interna-
tional settings for that Windows system. Default currency names used by 
Windows are three-character ISO 4217 abbreviations such as USD for US 
dollars, CHF for Swiss francs, IDR for Indonesian rupiah, and BOB for 
Bolivian bolivianos. Default symbols are those that are commonly used in 
the countries of origin, as there are no international standards for these.

The currency you use for a RILSIM analysis can be completely different 
from the default currency on your Windows-based computer. Simply re-
place the default entries with your own text and then execute the Update 
Data button.

Decimal-Point Symbol
RILSIM permits the use of either a comma (,) or dot (.) as a decimal-
point symbol. (The dot may alternatively be referred to as a period or 
full stop.)

When an empty RILSIM database is created with the File | New command, 
the decimal-point symbol is set to the default for the Windows system on 
which RILSIM is being used. This depends upon the specifi c international 
settings for that Windows system.

You can change the decimal-point symbol by making a new selection from 
the drop-down list on the General Data Form. This change can be made 
at any time. The selected decimal-point symbol is saved with the RILSIM 
database and the same symbol is used each time the database is opened 
unless you select a new symbol and then re-save the database.

Unlike most other RILSIM data fi elds, when you change the decimal-point 
symbol it takes effect immediately, without waiting for you to press the 
Update Data button. The reason for this is that changing the decimal-point 
symbol modifi es an internal index within the Windows operating system 
itself. This index affects only the current RILSIM analysis and not any other 



55

RILSIM Overview

software you might have on your computer system (even another instance 
of RILSIM that might be running a different analysis simultaneously).

Because changes to the decimal-point symbol take effect immediately, it is 
not possible to switch back to the previous selection by pressing the Cancel 
Edit button. Instead you must select the previous decimal-point symbol 
from the drop-down list.

It’s important to recognize that changing the decimal-point symbol affects 
both input and output of numeric data. As an example, if you select the 
comma as the decimal-point symbol, you must then use commas whenever 
you enter numeric data requiring a decimal point. If you use the dot by 
mistake an error will result.

Preventing Decimal-Point Confl icts

RILSIM has been designed with “multiple document” capabilities. This 
means you can have more than one RILSIM database open simultaneously 
within a single instance of RILSIM. This can be helpful if you are doing 
comparative analyses. However, in order to open more than one RILSIM 
database within a single instance of RILSIM, all of the databases must 
use the same decimal-point symbol. Permitting databases with different 
decimal-point symbols to be open simultaneously would cause numerical 
confl icts among them. This limitation is caused by the way the Windows 
operating system treats decimal-point symbols. To give an example, if you 
are working with a database in which the comma has been specifi ed as 
the decimal-point symbol, RILSIM will refuse to open a second database 
in which the dot has been specifi ed as the decimal-point symbol.

You can work around this limitation in either of two ways:

• You can change the decimal-point symbol in the database that is already 
open so that it matches the decimal-point symbol of the additional 
database you want to open.

• You can launch a second instance of RILSIM and load the additional 
database into it. You will then have two instances of RILSIM running 
simultaneously, each with a different database. This will prevent any 
clashes between decimal-point symbols.

A corollary to this is that RILSIM will not permit you to change the deci-
mal-point symbol on the General Data Form if more than one database 
is open.
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Digit-Grouping Symbol
Digit-grouping symbols are commonly used to separate groups of digits 
within large numbers so that the numbers are easier to read. Typically, 
digits are clustered in groups of three. For instance, the number 25836562 
is easier to read if the digits are grouped as 25,836,562. In this case the 
digit-grouping symbol is a comma. RILSIM users can select from among the 
comma, dot, apostrophe, or blank space. The selection is made from a 
drop-down list on the General Data Form. Any change in the digit-group-
ing symbol takes effect immediately, without waiting for the user to click 
the Update Data button. To reverse the change, simply make a different 
selection from the drop-down list.

RILSIM does not permit the digit-grouping symbol and the decimal-point 
symbol to be the same, as this would interfere with interpretation of nu-
merical entries in data fi elds.

When a new RILSIM database is created with the File | New command, 
the digit-grouping symbol is set to the default for the Windows system 
on which RILSIM is being used. The default symbol depends upon the 
specifi c international settings for that Windows system. Regardless of the 
international setting, the user can select a new digit-grouping symbol at 
any time.

The digit-grouping symbol is used whenever RILSIM displays numbers 
larger than one thousand in data fi elds and in formatted reports and charts. 
In most data fi elds its use is optional for data entry. Certain data fi elds, 
however, prohibit the use of the digit-grouping symbol for data entry and 
will raise an error message if the symbol is encountered. If this happens, 
simply re-enter the number without the digit-grouping symbols.

When a RILSIM database is saved to a disk fi le, the digit-grouping symbol is 
written to the fi le and the same symbol will be used each time that database 
is opened unless you select a new symbol and then re-save the database.

Autosave
When working with a datafi le it is generally good practice to save the fi le 
frequently, especially when updating data; for instance, if you are creating a 
new database or editing data in an existing fi le. RILSIM provides an “auto-
save” feature to assist users who have diffi culty remembering to save their 
datafi les regularly. By default this feature is inactive. To activate it, select 
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the Autosave item from 
the Options menu. After 
selecting this item a dialog 
window like the one at right 
will appear. This allows you 
to specify an interval at 
which all open RILSIM fi les 
will automatically be saved.

The Autosave dialog window 
also permits you to choose a 
“persistence setting” for the 
autosave function. You can choose to activate autosave every time RILSIM 
is launched, or you can choose to let the autosave setting expire at the end 
of the current RILSIM session.

Regardless of the autosave setting, you can save any open fi le manually 
whenever you wish.

Go To
Sometimes it is convenient to be able to quickly change from one data 
form to another and at the same time open a specifi c record within the 
new dataset. This capability is provided by the Go To command, which is 
available from the Edit menu.

When you execute the Go To command, a dialog 
window like the one at left appears. The default 
dataset in the drop-down list corresponds to 
the data form currently being displayed, and 
the default record number is that of the record 
currently being displayed. To use the Go To 
dialog, proceed as follows:

• If you want to change datasets, select the name of the new dataset from 
the drop-down list.

• Enter a record number into the data fi eld or use the “spinner” buttons 
to increase or decrease the record number from its current value.

• Click the OK button to execute the command or click Cancel to close 
the dialog window without executing the command.
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Find
RILSIM’s Find command, which is available from the Edit menu, provides 
searching capabilities similar to those found in most word processing pro-
grams. However, searches always start at the beginning of the database (the 
General Data Form) and proceed through the database form by form and 
(for multiple-record datasets) record by record. The Personnel Assignment 
and Equipment Assignment data forms are not included in the search.

Executing the Find command brings up the dialog window shown below. 
Type the text or numeric data you want to fi nd in the edit fi eld of the dia-
log box. Then press the Find Next button to locate the fi rst instance of 
data that matches the search string. 
You can locate successive data records 
that contain the search string, if any 
exist, by successively pressing the Find 
Next button.

You can also set either or both of the following options by clicking the 
selection box next to the option label:

• Match whole word only – If you set this option, Find will locate only 
data comprising a whole word. If you entered Skidder in the edit win-
dow and then set this option, an equipment item named Rubber-Tired 
Skidder would be found because it includes Skidder as a separate whole 
word. However, a job title named Skidderman would not be found. If 
this option were cleared, both would be found.

• Match case – This option instructs Find to locate only data that match 
exactly the uppercase and lowercase letters as you enter them in the 
edit fi eld. If you enter Skidder in the edit window and then set this 
option, Skidder would be found but skidder would not.

After you have successfully located the item you are seeking, click the 
“Cancel” button to close the dialog window. The record containing the item 
sought will be displayed in RILSIM’s main window.

The Find command will locate matching data, if it exists, in protected data 
fi elds as well as in editable data fi elds. You can copy data from protected 
fi eld but you cannot change or delete the data.

For more information, look up “Find” in the online help index.
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Replace
An extension of the Find command, Replace allows you to fi nd text or nu-
meric data throughout the current RILSIM database and simultaneously 
replace it with data that you enter. Like the Find command, Replace is 
available from the Edit menu.

When the dialog window appears, type 
the search data in the upper edit win-
dow of the dialog box. Then type the 
replacement data in the lower edit 
window. Set or clear either or both of 
the search options (see the description 
of the Find command for details) and execute the Find Next button. If the 
search string is located, you can execute the Replace button to cause the 
data to be replaced, or you can press Find Next again to leave the data 
unchanged and search for the next occurrence of the search string. You 
can alternatively execute the Replace All button to replace all instances 
of the search string everywhere it occurs throughout the database. As with 
the Find command, the Personnel Assignment and Equipment Assignment 
datasets are both excluded from the search.

The Replace command will fi nd matching data in protected data fi elds 
as well as in editable data fi elds, but it can only replace data in editable 
data fi elds.

For more information, look up “Replace” in the online help index.

Sound Effects
RILSIM uses sound effects to provide audible feedback when commands 
are executed or when windows open or close. Many people appreciate 
receiving this type of feedback but others fi nd it intrusive. If you want to 
deactivate the sound effects, pull down the Options menu and select the 
RILSIM Sound Effects item. A message will appear indicating that you 
have deactivated the option. You can reactivate the sound effects at any 
time by selecting this item again.

For more information, look up “sound effects” in the online help index.

Note: The RILSIM Sound Effects option does not affect the standard Win-
dows dialogs such as popup error messages. Whether or not these dialogs 
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use sound effects, and if so which sound effects they use, is determined by 
settings in the “Sounds and Audio Devices” application in your Windows 
Control Panel. Error messages and informational windows invoked by 
RILSIM commonly use the “Asterisk” and “Exclamation” sounds defi ned 
in your Windows Control Panel. A few messages may use the “Critical 
Stop” sound. Other Windows-based sound effects may be used to signal 
the opening or closing of windows, the appearance of menus, and other 
actions. All of these are controlled by the Windows operating system and 
not by RILSIM.
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The fi rst step in learning to use a new software package is to try 
it out on a relatively simple example that is easy to understand 
and yet demonstrates what the software is designed to do. Even 
if such an example doesn’t use all of the capabilities of the soft-

ware, it can give you an appreciation for what the program is able to do, 
how effi cient it is, and whether or not it meets your requirements. This 
is the purpose of the simple example developed for this chapter. Then in 
Chapter 4 we’ll develop a more comprehensive example to let you see the 
full range of RILSIM’s capabilities in action.

Chapter Synopsis

The best way to become profi cient with any software package is by actually 
using it. RILSIM is no exception. This chapter takes you through a simple 
example to give you confi dence working with the software. The example 
will require you to examine each of RILSIM’s data forms and then use 
RILSIM’s computing power to make a scenario run. After you’ve obtained 
the solution you’ll be able to print a formatted report and two charts that 
will provide detailed information about the results.

Because “hands-on” experience with software is essential if you are to 
understand how it works, be sure to launch your own copy of RILSIM and 
work through the example yourself as you follow the explanations in this 
chapter. You should be able to replicate exactly the results shown for the 
example.
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Hutan Indah Example
This example shows you how to:

• Open an existing RILSIM database.
• Examine the data in the database.
• Make a scenario run.
• Examine a report of the results on-screen and print the report.
• Display and print two charts that will help you interpret the results 

of the scenario run.

This is not a comprehensive or necessarily realistic example. Its main fea-
ture is that it is simple and should therefore be relatively easy to follow. 
Here are the steps:

1. Launch your copy of RILSIM. If you’ve forgotten how to do this, see 
the instructions on page 12 of this User’s Guide.

2. Bring up the Open dialog by using the Open command, either by 
choosing Open from the File menu, clicking the shortcut button on 
the toolbar, or pressing CTRL+O. If you need help, look up “open” in 
the online help menu and choose the subtopic “command.”

3. Using the Open dialog, navigate to the Samples folder if necessary. 
This folder is located within another folder named RILSIM Data, which 
in turn is located by default in your My Documents folder. You may 
have designated a different location for the RILSIM Data folder when 
you copied the sample fi les the fi rst time you launched RILSIM. If you 
haven’t copied the sample datafi les to your hard disk, you won’t be able 
to work through this example on your own copy of RILSIM unless you 
enter all of the data by hand. If you want to copy the samples now, pull 
down the Options menu and click the item “Copy Sample Datafi les.”

4. When you’ve opened the 
Samples folder you should 
see a list of RILSIM data-
base fi les. Each fi le has the 
filename extension .rdb, 
the registered extension of 
a RILSIM database. The 
list will look something like 
the image at right, although 
some fi lenames in your list 
may differ from what you 
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see in this image. The 2.0 at the beginning of each fi lename is a nota-
tion used with the sample fi les to indicate that they are in the format 
used by RILSIM 2.0. Although RILSIM 2.0 can read fi les created with 
earlier versions of RILSIM, the new fi le format cannot be read by older 
versions of the software.

 In the Open dialog window, note that each fi lename is accompanied by 
an icon that looks like a pushpin holding a piece of yellow note paper. 
This is the small logo used by Windows to represent a RILSIM database 
fi le. Depending on your version of Windows, a different logo may be 
used until you reboot your system after installing RILSIM.

5. Click the fi le named 2.0 Hutan Indah.rdb. Its name will then appear 
in the “File name” edit box. Click the Open button to load the database 
from the fi le into RILSIM. Alternatively you can just double-click the 
fi lename and this will execute the Open command on that fi le. In ei-
ther case, RILSIM’s General Data Form should appear with the data 
entered as in the following image.

6. Note the following points about the data shown in this form:

• The area to be logged is 1.000 ha (one thousand hectares). If you 
click the drop-down list adjacent to the logging area data fi eld, you’ll 
notice that two options are available for measuring the logging area: 
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“ha” (for hectares), and “ac” (for acres, a unit of area commonly used 
in the USA). This example uses hectares.

• The decimal-point symbol selected for the analysis is a comma. This 
is indicated in a drop-down list at the right side of the data form.

• The “dot” character has been selected as the digit-grouping symbol 
to make large numbers easier to read. This is evident from the drop-
down list below the one provided for the decimal-point symbol.

• The currency to be used for the analysis is the Rupiah, the national 
currency of Indonesia. Its symbol is Rp.

• In the “Digits after Decimal” data block, note that the number of 
decimal places has been specifi ed as 0 for both time-based costs and 
for piece rates. The reason for this is that one rupiah has only a very 
small value. Therefore currency amounts are commonly rounded to 
the nearest whole rupiah rather than carrying fractional parts of a 
rupiah. At the time of this writing (August 2004), one rupiah has 
an international value of about 0,0001080 US dollar.

• The annual interest rate to be used in calculations involving the time 
value of money is 15% and interest is to be compounded monthly.

• The simulation time unit to be used for the analysis is one week.

7. Now that you’ve looked over the data in the form, let’s make a change 
to one of the values. Select the text in the data fi eld labelled “Name 
of Analyst.” You can do this by clicking in the data fi eld with your left 
mouse button and then dragging across all of the data in the fi eld while 
holding down the left mouse button. Or, if the cursor (a blinking vertical 
line) is still located in the “Company or Organization” data fi eld, just 
press the Tab key on your keyboard. This will move the cursor to the 
next data fi eld and select all of the data in that fi eld.

 After selecting the data, type your own name into the fi eld. This will 
replace the name that’s already there. Then execute the Update Data 
command by either (a) clicking the Update Data button, (b) clicking 
the corresponding toolbar button (an image of a clipboard with a check 
mark), or (c) selecting the Update Data command from the Record menu. 
In fact, try all three methods; executing Update Data multiple times 
won’t cause any harm. You should hear an audible sound confi rming 
the action each time unless you have turned off RILSIM’s sound effects 
(for information about how to do this, look up “sound effects” in the 
online help index or refer to the discussion on page 59).
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8. Executing the Update Data command has caused your name to replace 
the previous name for the current analysis. To make this change a per-
manent part of the database, save the fi le to your hard disk. You can 
do this by clicking the toolbar button (an image of a diskette), select-
ing the Save command from the File menu, or by using the CTRL+S 
keyboard shortcut. RILSIM will confi rm that the fi le has been saved.

 You can also save the fi le under a new name if you wish; simply select 
the Save As command from the File menu and enter the new name in 
the edit fi eld of the dialog window. The dialog window also allows you 
to save the fi le in a new location if you wish.

9. Now open the Wage Data Form. Recall that you can do this either by 
clicking the tab near the top of the form window, or you can select the 
name of the form from the View menu.

 In the Wage Data Form you’ll note that data records have been pre-
pared for eight personnel categories. Costs for six of these are based 
on time wages and for the other two on piece rates. You should be able 
to move from record to record by using the four pointer buttons on the 
toolbar. For instructions look up “toolbar” in the online help index. Then 
page down in the help topic until you see the descriptions for the First 
Record, Next Record, Previous Record, and Last Record buttons.

 Also remember that if you need information about a particular data 
fi eld, you can use the toolbar’s Context Help button to obtain informa-
tion immediately.

10. Find record number 5 (see the image on the following page), which 
provides data for a personnel category whose job title is “Mapping 
Technician.” Workers in this category are compensated by time-based 
wages and each is paid a base wage of Rp 4.100.000 (four million, one 
hundred thousand rupiah) per wage period. Note that no information 
is provided about the length of the wage period . We’ll see shortly that 
the wage period length can be inferred as one month. It is not actually 
necessary for us to know this, although the person who entered the 
data originally must of course have known it.

 The payroll cost rate for this category of worker is 35%. Payroll costs 
include payroll taxes, fringe benefi ts, and other items of cost that are 
directly related to a worker’s base wage. The actual payroll cost (in the 
protected data fi eld) is calculated by multiplying the base wage by the 
payroll cost rate; in this case the result is Rp 1.435.000.
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 Workers in this category are paid a fi eld allowance of Rp 400.000 per 
wage period. There are no other costs. Hence the total cost per wage 
period is Rp 5.935.000. You should be able to verify this sum.

11. Now direct your attention to the “Daily and Hourly Cost” data block. 
Note that the number of workdays per wage period is 22. This is a com-
mon average number of workdays per month; hence we can infer that 
the wage period being used for this personnel category is one month. 
The daily cost is computed by dividing the total cost per wage period 
by 22. Similarly, the hourly cost is computed by dividing the daily cost 
by the number of scheduled workhours per day.

 It’s well to note that any length of wage period can be used on this 
data form. The objective of the form is to derive an hourly cost that 
represents the total cost (per hour) associated with each worker in the 
personnel category represented by the data in the form. For Mapping 
Technicians the total hourly cost is Rp 33.722.

12. Next, move to record number 1 (see the image on the opposite page). 
The job title for this record is “Chainsaw Operator (Rp/m3).” Compensa-
tion for any worker in this category is based on a piece rate computed 
on each cubic meter of timber produced. The “Daily and Hourly Cost” 
data block is missing from this form because it is not relevant for a 
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piece rate. Instead, the total piece-rate payment is calculated in the 
same way as the total cost per wage period in the form on the preceding 
page.

 The other wage data records are all similar to the two shown on this 
and the previous page. You may want to inspect them to verify that 
the data appear to be consistent.

13. Now open the Equipment Data Form. There are fi ve equipment data 
records. Costs for all fi ve types of equipment have been recorded as 
hourly costs. Piece rates could also have been used, although this is 
less common for equipment than for wages. As you look through the 
equipment data records, note that detailed cost breakdowns have only 
been prepared for two items: a chainsaw and a skidder (the latter is 
shown in the image on the following page). The other equipment items 
are all less expensive and the costs have been entered only in a single 
category rather than being disaggregated into multiple categories.

 In the image on the following page, note the small button that resem-
bles a spreadsheet next to the Depreciation data fi eld. Clicking this 
button will open a “Depreciation Cost Worksheet” that you can use to 
calculate the cost of depreciation for the equipment item. If you click 
the button you’ll see that a worksheet appears but it contains no data. 
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This is because the depreciation cost has been entered directly into the 
data fi eld on the Equipment Data Form, rather than being calculated 
through the worksheet. In Chapter 4 we’ll see an example that uses 
the Depreciation Cost Worksheet, but for now we’ll just leave the value 
that has been entered directly. Click the Cancel button to close the 
worksheet

14. After you’ve looked over the equipment data records, open the Activ-
ity Data Form. You should be able to verify that three activities have 
been defi ned: “Unit Layout,” “Inventory,” and “Logging.” If you open 
the Activity Chart you’ll see that Unit Layout comes fi rst, followed by 
Inventory, which is followed in turn by Logging. Each of the latter two 
activities has a Type 1 precedence relationship with the activity that 
precedes it. This means that each activity will begin when its preced-
ing activity ends. No startup delays have been specifi ed for any of the 
activities.

 The Activity Data Form corresponding to the Logging activity (Record 3 
of the activity dataset) is shown on the opposite page. You should 
confi rm that the data shown in the illustration are the same as in the 
corresponding form on your computer screen.
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 Data for all three activities are summarized in the table on the following 
page. You should be able to verify that the data entries in the activity 
records and in their personnel and equipment assignment subrecords 
of the RILSIM database match the values shown in the table.

 One of the data values that may look slightly odd to you is the as-
signment of 0,25 Felling Supervisor to the Logging activity (see the 
table on the following page). Such an assignment is perfectly legal, 
although perhaps not common. It implies that one-fourth of the Felling 
Supervisor’s time is allocated to the logging operation being analyzed 
in this RILSIM model. The remainder of the Felling Supervisor’s time 
is not accounted for within this model.

15. Before moving on, let’s take a look at the Diffi culty Index. On the Activ-
ity Data Form, go to Activity 1, Unit Layout. The value of the Diffi culty 
Index for this activity (and for the other two activities also) is shown as 
1,25. The Diffi culty Index is intended to measure the perceived overall 
diffi culty of the current activity relative to the same activity under 
“average” operating conditions. The default value whenever you create 
a new database is always 1,0. Generally speaking, logging is more dif-
fi cult in steep, rough topography than on fl at or gently sloping ground. 
When comparing an operation on steep slopes with another operation 
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on fl at ground you might therefore want to use a higher diffi culty index 
for the operation on steep slopes.

 As mentioned in Chapter 2 (page 42), the button adjacent to the Dif-
fi culty Index edit fi eld will open a worksheet that can be used to cal-
culate a diffi culty index for the activity. If you compare the Diffi culty 
Index buttons on the data forms for Activities 2 and 3 with the one for 
this activity, you’ll notice that this one is colored green, whereas the 
other two are white. White means that the activity has no associated 
worksheet, whereas a colored button indicates that a Diffi culty Index 
worksheet has been created for that activity and stored as part of 
the datafi le. (For more information about the color scheme used with 
RILSIM’s worksheet buttons, look up “button, worksheet” in the index 

Activity Item Quantity

Unit Layout Operating hours per week 35

Production rate 2,5 ha/hr

Personnel assignments
 Senior Laborer
 Laborer
 Mapping Technician

2
2
1

Equipment assignments
 Unit Layout Equipment 1

Inventory Operating hours per week 40

Production rate 2 ha/hr

Personnel assignments
 Survey Technician
 Laborer

1
2

Equipment assignments
 Inventory equipment & tools 1

Logging Operating hours per week 40

Production rate 12,77 m3/hr

Production/ha 25 m3/ha

Personnel assignments
 Chainsaw Operator (Rp/m3)
 Felling Supervisor
 Laborer
 Skidder Operator (Rp/m3)

1
0,25
1
1

Equipment assignments
 Chainsaw
 Felling Materials & Tools
 Skidder Caterpillar 527

1
1
1
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of RILSIM’s online help.) Now, click the button on the data form for 
Activity 1. A worksheet like the one shown below will open.

 This worksheet operates like a simple spreadsheet to calculate an aver-
age diffi culty index weighted by area. Note that the decimal point is the 
same as specifi ed on the General Data Form. Ten rows are provided in 
which data can be entered.

 You can use the context help button  on the dialog window’s title 
bar to bring up a help message on any aspect of the worksheet. Move 
around the work sheet by pressing Enter, Tab, or the up and down ar-
row keys. Shift+Tab moves the selection backward. You can also click 
with the mouse button to move directly to any cell. You cannot select 
any of the cells in the title row at the top of the worksheet or in the 
totals row at the bottom of the worksheet.

 The two columns on the left of the worksheet are used for documenta-
tion. In the image above, the cell with the entry “Flat” in the “Terrain 
Feature” column has been selected. To replace the current text in the 
cell, just start typing.

 The two columns on the right require numeric data. Values in the Area 
column should add to the total logging area for the project. The three 
terrain features shown in the Hutan Indah worksheet have areas of 
400, 400, and 200 ha, respectively. If you calculate a weighted-aver-
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age diffi culty index using these areas and their corresponding index 
values (1,0, 1,25, and 1,75) you will obtain the overall index of 1,25 as 
indicated in the totals row of the worksheet. Note that you can change 
the number of digits displayed after the decimal point in each of the 
columns. This can be done by clicking the up or down arrows adjacent 
to the numbers in the “Digits after the Decimal Point” data block above 
the worksheet, or by typing numbers directly in either of the two data 
fi elds.

 To see how the spreadsheet works, click the cell that contains the dif-
fi culty index for the terrain feature named “Hilly.” The current value 
in this cell is 1,25. Type 1,5 and then press the Enter key. The overall 
diffi culty index in the totals row changes to 1,35.

 When you’ve fi nished exploring the worksheet, execute the Cancel 
button. This will return you to the General Data Form without chang-
ing the value of the Diffi culty Index already recorded there.

 For more information about the diffi culty index and its worksheet, look 
up “diffi culty index” in RILSIM’s online help index.

16. Now open the Scenario Data Form, which should appear as shown at the 
top of the next page. The data on this form indicate that the simulation 
will only compute costs (because the “Calculate Net Revenue” check 
box has been cleared). Also, costs will be discounted to the beginning of 
time period 0, which represents the starting time for the operation.

 After you have looked over the Scenario Data Form to your satisfaction, 
execute the Run Scenario button. This will initiate the simulation, 
which should require only a small fraction of a second. You should be able 
to verify that the total simulated operating time for the three activities 
in this simulation is slightly more than 91 weeks. The nominal total 
cost of the operation should be shown on your form as Rp 1.287.342.731 
and the discounted total cost as Rp 1.092.805.169. The total revenue 
and net revenue data fi elds are empty because we did not calculate net 
revenue for this analysis.

17. You’ve now run a full simulation, even though it’s a rather simplistic 
one. The fi nal steps are to examine the results on-screen and to print 
a summary report and two charts on your printer.

18. One way to examine the simulation results on-screen is to run through 
all of the records in the Activity Data Form. The protected data fi elds 
on that form will now have been fi lled in with results from the simula-
tion. The image at the bottom of the opposite page shows the form for 
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Activity 3, Logging, following the simulation run. Note that protected 
data fi elds show the activity’s beginning time, ending time, the quantity 
produced, and the total activity cost (reported both as a nominal cost and 
as a discounted cost). The activity unit costs were fi lled in previously, 
as a result of assigning personnel and equipment to the activity.

The Formatted Simulation Report
To obtain a more concise summary of the results of the simulation run, you 
can use RILSIM’s Print Preview command, which is available from the File 
menu or the toolbar. This command displays a window showing a format-

ted summary report as it would 
print on your default printer 
with the currently selected 
paper size and orientation. To 
change any of these defaults, 
fi rst execute the Print Setup 
command from the File menu. 
In the dialog window that ap-
pears (see the image at left) 
you can change the paper size, 
the page orientation (portrait 
or landscape), and the paper 
source if your printer offers 
more than one. You can also 

select a different printer if more than one is available to your computer. 
If the Properties button is enabled for your printer, you can execute it to 
bring up your printer’s property pages. These will normally provide ad-
ditional printing options.

When you are satisfi ed with the print setup, executing the Print Preview 
command from the File menu or toolbar will bring up a window like the one 
shown on the opposite page. The image within the window shows how your 
simulation report would print on the currently selected printer, with the 
current settings as specifi ed in the print setup dialog window. The image 
shown here is for B5 paper in landscape orientation, as set in the Print 
Setup window shown above. You can “zoom in” to the image in order to 
read the details of the report, and then “zoom out” again to get an overview 
of the printed page. For reports that occupy more than one page you can 
preview each page separately. You can also select a two-page mode that 
gives you an overview of two pages at once.
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Print preview is useful not only for seeing how the report will fi t onto the 
printed page but also for quickly scanning the simulation results to see if 
something needs to be changed before you actually commit the report to 
paper.

When you’re ready to send the report to the printer, select the Print com-
mand from the File menu. Alternatively you can click the printer toolbar 
button (a button that resembles a printer), or you can press CTRL+P. Any 
of the three methods will bring up the familiar print dialog window. If 
you have a multi-page report and you want to print only part of it you can 
specify a range of page numbers to be printed. You can also modify your 
printer’s properties if the printer supports this option. Otherwise you’ll need 
to make changes in the Print Setup dialog before printing. The image on 
the next page shows the report for the Hutan Indah example.

A RILSIM report consists of two sections: An overall summary, which 
contains mainly information from the General Data Form and the Scenario 
Data Form; and an activity report. The latter lists all activities in the order 
they would occur during the logging operation (not necessarily in order by 
activity number). For each activity, the beginning and ending times are 
shown, along with the duration of the activity. These times are all indicated 
in the designated simulation time unit. For the Hutan Indah example this 
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unit is measured in weeks. The activity report also indicates the nominal 
cost for each activity, and the corresponding discounted or compounded cost. 
If the activ ity’s cost occurs before the reference time for interest calculations 
as set in the Scenario Data Form, the cost is compounded forward to that 
time; otherwise it is discounted back to the reference time.

Below the activity report are two or four “totals” rows. The fi rst of these 
indicates the total projected operating time. This is always the same as 
the ending time of the fi nal activity. The second “totals” row shows the 
total nominal revenue and the discounted or compounded total revenue if 
the net revenue option was selected; otherwise it is not present. The third 
row shows the total cost and discounted or compounded total cost for all 
activities. The fi nal row shows the nominal net revenue and the discounted 
or compounded net revenue if the net revenue option was selected by the 
user. The second and fourth rows of this block are not present in the report 
shown above because the Hutan Indah example uses total cost only.

 RILSIM Simulation Report

 Section 1. Overall Summary
 Project Description ........................Hutan Indah Sample Problem
 Organization ...................................Hutan Indah
 Analyst ........................................... Ir. Rimbawan
 Scenario .........................................Total Cost of Three Activities
 Logging Area ................................. 1.000 ha
 Annual Interest Rate ...................... 15 %
 Interest Compounded .....................Monthly
 Reference Time for Interest ........... Beginning of Week 0
 Simulation Time Unit .................... 1 week
 Comparison Basis ..........................Total Cost
 Log Price ........................................Not Applicable
 Currency .........................................Rupiah (Rp)

 Section 2. Activity Report
Note: Costs in the far-right column below have been discounted or compounded to the reference time indicated in Section 1 
to account for the time value of money at the specifi ed interest rate and compounding frequency.

Activity Number and Name

Time Period 
(weeks) Activity 

Duration 
(weeks)

Nominal
Cost (Rp)

Compounded 
or Discounted 

Cost (Rp)Begin End

1 Unit Layout 0 14,286 14,286 49.002.841 47.944.197
2 Inventory 14,286 29,911 15,625 39.924.006 37.422.718
3 Logging 29,911 91,089 61,179 1.198.415.884 1.007.438.255

Total Projected Operating Time (weeks) 91,089

Total Cost and Discounted Total Cost (Rp) 1.287.342.731 1.092.805.169

Tuesday, 10 August 2004 22:16:55 Page 1 of 1
D:\Documents\RILSIM Data\Samples\2.0 Hutan Indah.rdb
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Beneath the “totals” rows is a “footer,” which appears on each page of the 
report. The footer indicates the date of the analysis, the path name of the 
RILSIM database fi le used for the simulation, and both the current page 
and the total number of pages in the report.

Save Report to Disk
An additional capability offered by RILSIM with respect to formatted 
simulation reports is the option to save a report to a disk fi le. This option 
is available from the File menu (select the Save Report As command). By 
default the command will save the report with a .txt fi lename extension. 
You can use a different extension if you wish, but this one has the advan-
tage that it is automatically recognized by most spreadsheet programs 
and word processors.

The report generated by the Save Report As command provides the same 
information as shown in the illustration on the previous page but in a 
“plain text” form that you can read into a word processor or a spreadsheet 
program. In this report, columns of data are separated by tab characters. 
Most spreadsheet programs have the ability to read such “tab-delimited” 
text fi les and parse the data into columns. Word processors can also read 
such fi les but you may have to convert the text into a table in order to for-
mat it conveniently. See the help system provided with your spreadsheet 
program or word processor for instructions on how to convert text fi les.

RILSIM Charts
In addition to the formatted text reports, RILSIM can also produce two 
graphical reports that you may fi nd helpful for analyzing logging operations. 
The fi rst of these is a “Gantt Chart,” a type of chart that is widely used in 
project planning. The second is a bar chart that summarizes activity costs. 
You can view both types of charts on-screen, and you can also print them, 
using the full formatting capabilities of your printer.

Gantt Chart

This type of chart is designed to help you visualize the starting times, 
ending times, and durations of the activities in your project, as well as the 
overall project duration. It was developed by Henry L. Gantt, an American 
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engineer, in the early 1900s as a way to graphically portray relationships 
among activities in a complex project.

The Gantt Chart for the Hutan Indah example is shown below. The main 
chart has four “columns”: An “Activity” column, two “Time” columns, and 
a column containing bars that represent activity times. Within this last 
column, each activity is associated with a horizontal bar whose length is 
scaled to represent the duration of the activity. The bar is plotted so that 
its beginning and ending points are scaled relative to the duration of the 
entire project; thus you have a visual depiction of the progression of ac-
tivities through the project. The columns to the left of the bars show the 
actual beginning and ending times of the activities so that you can easily 
compare with the plotted values.

After a scenario has been run, click the “Gantt Chart” button on the Scenario 
Data Form to open a new view window that displays the Gantt Chart. This 
is RILSIM’s “chart-view” window, which is used for the Gantt chart and also 
for the activity-cost bar chart discussed in the fi nal section of this chapter. 
The chart-view window has its own menus and toolbar, which differ from 
those of the main RILSIM window. For detailed explanations of the menu 
and toolbar options, look up “Gantt chart” in RILSIM’s online help, then 
select the “menus” or “toolbar” subitem.

When you click the Gantt Chart button on the Scenario Data Form, RILSIM 
creates a Gantt chart using data from the most recent scenario run. From 
within the chart-view window you can then:

• Use the “Page & Print Setup” option from the File menu or from 
the toolbar (the button that resembles a printer with a magnifying 
glass in front of it) to change the page margins, column widths, or 
the scaling and labelling of the axis. The Gantt chart shown above 
was created with the default settings and then the “Activity” column 
was narrowed to remove excess space.

RILSIM Gantt Chart
..............................Project Hutan Indah Sample Problem

...........................Scenario Total Cost of Three Activities

Time, weeks
Activity Begin End 0 10 20 30 40 50 60 70 80 90
  1 Unit Layout 0,00 14,29
  2 Inventory 14,29 29,91
  3 Logging 29,91 91,09
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• From within the Page & Print Setup dialog window you can go di-
rectly to the “Print Setup” dialog to change the printer, paper size, 
page orientation, or other options. The Print Setup dialog is also 
available as a separate item from within the File menu.

• To see how the chart will look when printed with the current set-
tings, select the “Print Preview” command from the File menu or 
from the toolbar. In the chart-view window, the Gantt chart is 
scaled to the computer screen rather than to the size of the printed 
page, so you need print preview to anticipate how it will actually 
look when printed. If you want to make changes, pull up the “Page 
& Print Setup” dialog, change one or more settings, and then use 
print preview again to check the page before printing it.

• You can also change the size of the font used in the chart if you 
wish. You might want a large font, for instance, if you are preparing 
a slide for a presentation, or you might want a small font in order 
to fi t a large chart onto a small page. The commands to change the 
font size are available from within the Edit menu, or you can use 
the following keyboard shortcuts:

  Increase font size by 1 point CTRL+Up Arrow
  Reduce font size by 1 point CTRL+Down Arrow
  Reset the font to the default size CTRL+Home

 Font sizes can range between a maximum of 20 points and a mini-
mum of 5 points (the default size is 9 points). After changing the 
font size you’ll typically need to change some of the column widths 
so that the chart will print the way you want it.

• The Options menu for the Gantt chart contains only one item: “Unsort 
Activity List.” You can select this item if you want to change the 
order in which the activities are listed within the chart. By default, 
activities are listed in the order they would occur during the log-
ging operation. This “time-sorted” order may differ from the order 
in which the activities were added to the activity dataset (for the 
Hutan Indah example, it does not; the three activities occur in the 
same order as they were entered into the dataset). In some situa-
tions you might want the activities to be listed numerically as they 
were entered into the dataset. Choosing “Unsort Activity List” will 
accomplish this.

 It’s important to note that after you choose the “Unsort Activity List” 
option, it will affect all of RILSIM’s reports and charts (except the 
Activity Chart, which has its own sorting order). To reset sorting of 
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the activity list to the default order, select the item from the Options 
menu again. It will now be shown as “Sort Activity List.” Incidentally, 
the “Unsort Activity List / Sort Activity List” item is available not 
only from the chart-view Options menu but also from the Options 
menu provided in RILSIM’s main window. This is because you may 
want to change the sorting while printing a formatted simulation 
report, which is done from the main window.

• Once you are satisfi ed with the formatting of the Gantt chart, you 
can print it by selecting the “Print Chart” option from the File menu 
or from the toolbar.

Activity-Cost Bar Chart

Bar charts are widely used to summarize costs or other quantities because 
they allow users to quickly visualize results for a large number of items. 
RILSIM’s bar chart allows you to compare the individual activity costs for 
the simulated logging operation.

Click the “Bar Chart” button on the Scenario Data Form to create an activ-
ity-cost bar chart using data from the most recent scenario run. This will 
open RILSIM’s chart-view window and display the bar chart. The chart for 
the Hutan Indah example is shown below. Notice the following differences 
between this chart and the Gantt chart discussed earlier:

• The bar chart has three “columns”: An “Activity” column, a “Cost” 
column, and the column where the bars are drawn.

• For this particular bar chart, axis values have been scaled by mil-
lions of currency units. Recall that the unit of currency for the Hutan 
Indah example is the Indonesian Rupiah and that an individual 
rupiah has a relatively small value. This means that the cost values 
being displayed on the bar chart are relatively large (the largest, 
corresponding to the Logging activity, is Rp. 1.007.438.255, slightly 

RILSIM Bar Chart (Present Value of Activity Costs)
..............................Project Hutan Indah Sample Problem

...........................Scenario Total Cost of Three Activities

Cost, Rp
Activity Present Value 0 100 200 300 400 500 600 700 800 900 1000

Rupiah (millions)

  1 Unit Layout 47.944.197
  2 Inventory 37.422.718
  3 Logging 1.007.438.255
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more than one billion—thousand million—rupiah). When faced with 
such large numbers, RILSIM automatically scales the axis so that 
the labels are more readable and will fi t more conveniently within 
the available space. You can change the scaling if you wish, or turn 
it off altogether, through the Page & Print Setup dialog window.

This particular bar chart is not very revealing because 92% of the total cost 
is tied up in a single activity, Logging. The examples that we’ll consider in 
Chapter 4 have larger numbers of activities with costs distributed more 
evenly, so the bar charts are helpful in allowing users to quickly assess 
differences among activity costs.

Nominal Cost vs. Present Value

The bar chart is displayed within RILSIM’s chart-view window, so it offers 
the same capabilities as discussed earlier for the Gantt chart. In addition, 
the Options menu for the bar chart provides one additional item: “Show 
Nominal Costs.” This isn’t available for the Gantt chart because Gantt 
charts are concerned with time, not cost.

In the image of the bar chart on the opposite page, notice that the chart 
title and the header for the cost column both indicate that the costs are 
measured in “present value.” This is a shorthand way of saying that the 
costs have been compounded or discounted using the interest rate and 
compounding frequency specifi ed on the General Data Form, together with 
the reference time period specifi ed on the Scenario Data form.

Whenever you create a bar chart by clicking the “Bar Chart” button on the 
Scenario Data Form, RILSIM assumes you want to use present values. In 
some cases, however, you may wish instead to use nominal values—that 
is, actual cost values that have not been adjusted for the time value of 
money. This is the purpose of the “Show Nominal Costs” item in the Op-
tions menu. Simply select that item from the menu and the chart will be 
redisplayed using nominal costs. To switch back to present values, select 
the same item again from the Options menu. It will now appear as “Show 
Adjusted Costs”

It’s important to know that the “Show Nominal Costs” setting is valid only 
while the current chart window remains open. If you close a bar chart and 
then open it again later, the default setting (showing present values of 
activity costs) will be reinstated.
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In the course of developing RILSIM we relied heavily on experience from 
a study comparing conventional logging costs with those of reduced-
impact logging in the eastern part of the Amazon Basin in Brazil. The 
study was undertaken by the USDA Forest Service in cooperation with 

the Tropical Forest Foundation (TFF) and its Brazilian counterpart Instituto 
Floresta Tropical (IFT). Assistance was also provided by the University of 
Florida; EMBRAPA-CPATU, the Brazilian agriculture and forestry research 
institute for the Eastern Amazon; and IMAZON (Instituto do Homem e 
Meio Ambiente da Amazônia), a Brazilian non-governmental organization. 
The study was funded by the International Programs Offi ce of the USDA 
Forest Service and by the US Agency for International Development. An 
important attribute of this study is that it fully documents every item of 
cost and explains every assumption that was made in preparing the report. 
The example in this chapter is drawn from that study.

Chapter Synopsis

The focus of this chapter is on a real example drawn from real life. As 
developed here, the example has two purposes: (a) To let you see the full 
range of RILSIM’s capabilities in action; and (b) To demonstrate some of the 
fundamental differences between reduced-impact logging and conventional 
logging as identifi ed in the study cited above.

The best way to fully understand the example in this chapter is to launch 
your own copy of RILSIM and work through the example yourself as you 
follow the explanations. You should be able to replicate exactly the results 
shown in this chapter.
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TFF Brazil Example
Now that you’ve worked through the Hutan Indah example from Chapter 3, 
it’s time to try a more comprehensive example. For one thing, the Hutan 
Indah example considers only a single logging operation so it’s not possible 
to compare the results with those from an alternative operation. In most 
situations you’ll want to compare the costs of reduced-impact logging with 
the costs of conventional logging under identical local conditions. This 
example will show you how such comparisons can be made.

As mentioned on the previous page, information for this example is derived 
from an actual study that was carried out in Brazil. A detailed report de-
scribing that study is available in the TFF Report folder on the RILSIM 
CD-ROM. The report is provided in two formats: As a Microsoft Word 
document and as an Adobe PDF fi le. You can also obtain the report directly 
from the website of the Tropical Forest Founda tion at

http://www.tropicalforestfoundation.org/research/economic-benefi ts

You can fi nd a reference to this report under “TFF” in RILSIM’s online 
help index. For the lit erature citation see online help or refer to the cita-
tion for Holmes et al. (2000) on page xxiv in the Introduction to this User’s 
Guide.

In working through this example you will fi nd it helpful to have a copy of 
the TFF report available so that you can refer to it. We indicate sections 
of the report from which data have been taken rather than reproducing 
the details here.

RILSIM modeling techniques that are demonstrated in the TFF example 
include the following:

• Use of multiple personnel categories that are identical except for 
the job titles, to facilitate assignment of personnel to activities.

• Incorporation of zero-cost equipment items for certain activities.
• Use of precedence relationships to correctly specify the timing of 

activities.
• Incorporation of a support activity into the analysis.
• Analysis of total revenue and net revenue in addition to total cost.
• Comparing results for multiple RILSIM simulations.

In this chapter we assume you have already worked through the Hutan 
Indah example of Chapter 2 and that you are familiar with the various 
commands, data forms, and procedures used in a RILSIM analysis.

http://www.tropicalforestfoundation.org/research/economic-benefits
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Data for the TFF example have been stored in two RILSIM database fi les, 
one for reduced-impact logging and the other for conventional logging. Both 
are included with the set of sample datafi les provided with the RILSIM 
installation. If you haven’t copied the sample datafi les to your hard disk, 
you won’t be able to work through this example on your own copy of RILSIM 
unless you enter all of the data by hand. If you want to copy the samples 
now, pull down the Options menu and click the item “Copy Sample Data-
fi les.” If you need help with this, look back at the section entitled “First 
Launch” on page 13 of Chapter 1.

Reduced-Impact Logging Analysis
1. Open the RIL Database. After you’ve launched RILSIM, open the 

fi le named TFF RIL.rdb from the folder RILSIM Data\Samples. The 
General Data Form will appear, as shown below. Verify that the data 
for the example are as follows:

• The area to be logged is 100 ha. The TFF study involved harvesting 
a series of 100-ha blocks. Some of the blocks were assigned to the 
reduced-impact logging treatment and others to the conventional 
logging treatment. For our analyses in this chapter we’ll simulate 
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harvesting of two identical 100-ha blocks, one with reduced-impact 
logging and the other with conventional logging.

• The decimal-point symbol is a dot (full stop or period).

• The digit-grouping symbol is a comma.

• The annual interest rate to be used is 27.4%. This is a relatively 
high rate of interest but it is not unusual for a country like Brazil 
that has historically experienced high rates of infl ation.

• Interest is to be compounded monthly.

• The simulation time unit is one week.

• The currency to be used is US dollars, for which the symbol is $. 
Although the study was carried out in Brazil, the TFF publication 
reports the results in US dollars because the publication was intended 
for an international audience.

• Two decimal places are to be used for displaying time-based costs 
and fi ve decimal places for piece rates. Actually, only time-based 
costs were used in this study.

2. Wage Data Form. Click the tab to open this form and verify that data 
have been entered for 14 personnel categories. The data form for one 
personnel record is on the opposite page. All personnel cost data used 
in this example were extracted from the table in Appendix 5 of the TFF 
report.

 If you compare Wage Data Forms from the RILSIM database with 
information presented in the TFF appendix you’ll note that some job 
titles have been renamed (as an example, we’ve changed “Sawyer” to 
“Chainsaw Operator”). Also, some of the personnel categories have been 
reproduced several times with slightly different job titles. For instance, 
the TFF report includes a category named “Leadman / Technician II.” 
In the RILSIM datafi le we have used this single category as the basis 
for four different personnel categories: “Felling Supervisor,” “Inventory 
Technician,” “Survey Technician,” and “Technician.” Although the cost 
data are identical for all of these, defi ning multiple personnel catego-
ries in this way facilitates assignment of personnel to activities. Even 
though the Felling Supervisor and Survey Technician are paid at the 
same rate, their job titles clearly suggest different kinds of activities 
to which each should be assigned.
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 You should run through all records in the Wage Data Form and com-
pare the data entered in each record with the information provided in 
Appendix 5 of the TFF report. Note particularly that the payroll cost 
rate varies among the different personnel categories (47.16% for some 
categories, 38.83% for others). The base wage of course differs among 
the personnel categories, but most other entries are the same. One dif-
ference is that chainsaw operators work an average of only 6.15 hours 
per day as compared to 8 hours per day for other workers.

3. Equipment Data Form. You should verify that data have been entered 
for 23 equipment categories.

 Unlike the personnel data, no single summary of equipment costs is 
provided in the TFF study. Smaller-cost items, such as “Block Layout 
Materials,” are listed in Appendix 6a of the TFF report. Costs for larger 
items such as “Bulldozer Caterpillar D6 SR” are derived item by item in 
Appendices 6b through 6g. We’ve modifi ed the equipment-item names 
for some of these but you should recognize them easily. One equip-
ment item that you won’t fi nd in the TFF report is “Camp Facilities” 
(Record 3), which has an hourly cost of $0.06. This item will be used 
when we add a support activity, and we’ll explain the derivation when 
we come to it. The explanation is in item (j) on page 104.
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 The TFF report provides excellent information on how the equipment 
costs were calculated. Many of these cost items are also described in 
detail in RILSIM’s online help. You can fi nd the help topic for each cost 
category by using context help—click the Context Help button on the 
toolbar and then click the cost category. As an example, online help for 
“Taxes, Insurance & Interest” includes a detailed description of how 
that cost item can be calculated.

 Depreciation Cost Worksheet. Because depreciation represents a 
signifi cant portion of the ownership cost associated with major items 
of equipment, RILSIM provides a worksheet to help you calculate 
this cost. For an example, fi nd Record 18 in the Equipment Data 
Form. This record, which should appear as shown in the image below, 
summarizes costs for the equipment item named “Skidder Caterpillar 
525.” The depreciation cost is shown as $8.28/hr. However, note that 
the worksheet button adjacent to the Depreciation data fi eld is colored 
green. This indicates that:

(a) A Depreciation Cost Worksheet exists for this equipment item.

(b) The depreciation cost calculated by the worksheet agrees exactly 
with the number entered in the Depreciation data fi eld.
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For more information about the color 
coding used with worksheet buttons, 
refer to the topic entitled “worksheet 
button” in RILSIM’s online help. An 
easy way to open the topic is to click 
the Context Help toolbar button, 
then click the worksheet button on 
the Equipment Data Form.

Now open the Depreciation Cost 
Worksheet for the skidder by click-
ing the worksheet button on the 
Equipment Data Form. The work-
sheet should appear as shown in 
the image at left. The data for this 
worksheet have been entered from 
Appendix 6b in the TFF report (as 
have the data on the Equipment 

Data Form on the opposite page). By comparing the entries in the 
worksheet with the data in the appendix, you should be able to see how 
the depreciation cost has been calculated. You can change the entries 
in any of the data fi elds and then click the “Calculate” button to see 
how this will affect the results. You can also click the “Clear Form” 
button to remove all data from the worksheet; this is useful when you 
want to start a new calculation. For detailed instructions on how to 
use the worksheet, press the F1 key to pull up the relevant online help 
topic, or look in the online help index under “Depreciation Cost Work-
sheet”. When you’ve fi nished experimenting with the worksheet, click 
the “Cancel” button to return to the Equipment Data Form without 
changing the data value entered in the Depreciation data fi eld. If you 
click the “Save” button, the calculated value from the worksheet will 
be entered into the Depreciation data fi eld. Instead we want to make 
sure that the depreciation cost remains at the original value of $8.28/hr. 
Otherwise you won’t be able to reproduce exactly the results reported 
in this chapter when you make the simulation run for this example.

 Now that you know how to recognize the fact that a depreciation cost 
worksheet has been loaded with data, you’ll note as you browse through 
the equipment data records for this example that several other equip-
ment items also have depreciation cost worksheets. You might want 
to compare the calculations in those worksheets with the summaries 
in Appendices 6c through 6g of the TFF report in order to confi rm your 
understanding of how depreciation cost is calculated.
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 Adjusting for the Resale Credit Error. Due to a formulation error, 
the TFF analysis double-counts the resale credit. When an equipment 
item is sold or retired, any income resulting from the sale of the item 
or from the sale of parts salvaged from it represents an offset to the 
equipment cost. This income is commonly referred to as the “resale 
credit,” “salvage value,” or “residual value.” Normally the resale credit 
is subtracted from the purchase price when calculating depreciation cost 
(see “depreciation cost” in RILSIM’s online help for details). The TFF 
analysis does this, but also subtracts the resale credit as a separate cost 
item (this is done near the bottom of Appendices 6b through 6g in the 
TFF report). Because of this, the total costs reported in the appendices 
are too low by an amount equal to the resale credit. We have corrected 
this error in the datafi les used for the TFF analysis, so our comparisons 
with the TFF results will have to take this correction into account.

 Rounding Errors. For several equipment items not affected by the 
“resale credit” error, you may notice that the total cost in the RILSIM 
database differs by $0.01 from the total listed in the TFF report. This 
is due to the fact that the totals in the TFF report were taken from a 
spreadsheet program, so that the individual amounts do not always 
add to the totals as expressed to two decimal places.

 Zero-Cost Items. If you look carefully through the equipment dataset 
for this example, it may surprise you to note that two equipment items, 
“Data Processing Materials” (Record 6) and “Mapmaking Equipment” 
(Record 14), both have zero costs. The reason for this is to accommodate 
the RILSIM requirement that each activity must have at least one 
personnel category and at least one equipment item assigned to it. 
In the TFF study, data processing and mapmaking are presented as 
activities that have personnel costs only. We therefore created zero-cost 
equipment items that could be assigned to those activities.

4. Activity Data Form. A total of 14 activities have been defi ned. These 
activities correspond to those shown in Appendix 2 of the TFF report. 
RILSIM does not group activities into categories like “Pre-Harvest” 
as shown in the TFF Report, however. Also, the TFF report includes 
an activity called “Tree Hunting” for which there is no RIL cost. This 
activity, which differs slightly from “Tree Marking,” was used only in 
the conventional logging operation and is therefore not included in the 
datafi le for the RIL analysis. We’ll encounter it later when we open the 
datafi le for the conventional logging operation, which we will consider 
in the second part of this chapter.

 You should be able to verify that the activity unit cost ($/hr) for each 
activity as recorded in the Activity Data Form is the same as the cost 
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shown in Appendix 2 of the TFF report. A few amounts differ by $0.01/hr, 
for the reason discussed under “Rounding Errors” on the preceding 
page.

 The activity unit costs in the RILSIM database have been derived inde-
pendently from those in Appendix 2 of the TFF report, thus serving to 
validate the amounts reported in the TFF study (there are differences 
because of the resale credit error mentioned on the preceding page, 
but otherwise RILIM confi rms the activity costs reported by TFF). In 
RILSIM, activity unit costs are calculated automatically from the cost 
of personnel and equipment assigned to the activity. The number of 
persons and items of equipment assigned to each activity were derived 
from the footnotes associated with the table in Appendix 2 of the TFF 
report, and you should be able to verify that the assignments for each 
activity are correct.

 For example, if you open the Personnel Assignment Data Form cor-
responding to activity 1, “Block Layout & Line Clearing,” you’ll fi nd 
that one “Senior Laborer” and two “Laborers” have been assigned to 
this activity (thus there are two Personnel Assignment subrecords as-
sociated with this activity). These personnel assignments correspond 
respectively to the one “Qualifi ed Helper” and two “Helpers” listed 
in the footnote in Appendix 2 of the TFF report. Similarly, one set of 
“Block Layout Materials” has been assigned to the activity. The total 
unit cost for the activity can therefore be calculated as follows:

  $2.56/hr (one Senior Laborer) 
   + $1.99/hr  2 (two Laborers)
   + $0.18/hr (one set of Block Layout Materials)

 You can confi rm that this adds to the total of $6.72/hr as reported in 
the “Activity Unit Costs” data block for this activity. The piece-rate unit 
cost is reported as zero because none of the personnel or equipment 
costs were based on piece rates.

 Operating Hours. Data on operating hours per week were taken 
from Appendix 3 of the TFF report. The fi rst footnote in that appendix 
indicates that the operating time was 35 hrs/week (i.e., 7 hrs/day) for 
all pre-harvest and planning activities, 30.75 hrs/week (6.15 hrs/day) 
for felling and bucking, and 40 hrs/week (8 hrs/day) for all activities 
involving heavy machinery, like road construction, skidding, and log 
deck (landing) operations. You should verify that these are the values 
entered in the RILSIM activity records for operating hours per week.
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 Production Rates. Appendix 3 of the TFF report summarizes the 
production rates that have been entered into the RILSIM activity 
records. You can quickly verify the production rates in the RILSIM 
database against these fi gures, but you may also fi nd it worthwhile to 
read through the footnotes in that appendix to learn how the production 
rates were derived.

 One production rate in particular warrants additional explanation. 
The activity named “Log Deck Operations” includes sorting, measur-
ing, and loading of logs onto trucks at the landing. Given a suffi ciently 
large supply of logs, this activity commonly has a very high production 
rate. However, in most logging operations its productivity is limited 
to that of the skidding operation, because logs cannot be processed 
any faster than the rate at which they arrive at the landing. Thus, in 
the TFF report the production rate for log deck operations is listed as 
being identical to that of skidding. However, in a RILSIM model it is 
not necessary for these production rates to be identical. If information 
were available that would allow us to estimate a “pure” production 
rate for log deck operations, we could use that production rate instead. 
RILSIM would enforce the precedence relationship between skidding 
and log deck operations to ensure that the two production rates would 
remain consistent.

 Production per hectare. Production rates as measured in the TFF 
study were reported in hectares per hour for all activities but three: 
“Felling & Bucking,” “Skidding,” and “Log Deck Operations.” For 
these activities the production rates were measured in m3/hr. As a 
result, it’s necessary to also enter the production per unit area of forest 
(Production/ha) for each of these activities. For the TFF study, the 
average volume of logs produced per hectare from the operation was 
25.36 m3/ha. This is discussed in Section 3.1 of the report. You should 
verify that this is the value entered in the “Production/ha” data fi eld for 
each of these three activities. See the Activity Data Form for skidding 
on the following page as one example.

 Diffi culty Index. The diffi culty index for all activities has been set 
at the default value of 1.0. Topographic conditions were essentially 
uniform throughout the study area, so there is no need to adjust the 
default value for the diffi culty index. If you look through the activity data 
records for this example, you’ll see that nearly all of the Diffi culty Index 
Worksheet buttons have white faces, indicating that no worksheets exist 
for those activities. One activity, however (Skidding, Record 13), has a 
button with a red face. This means that a Diffi culty Index Worksheet 
exists for this activity, but the calculated value differs from the value 
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entered in the Diffi culty Index data fi eld on the Activity Data Form. 
The Diffi culty Index Worksheet has been created for this activity to 
give you some experience working with this type of worksheet. It has 
no real function in this example, because we intend to use the default 
value of 1.0. However, if you click the button, a worksheet should open 
that looks like the one on the following page. The values entered in 
this worksheet have no relevance to the logging operation in the TFF 
report; they are completely arbitrary. You may want to change some 
of the values to see how they affect the overall weighted average. You 
can also add more values or delete some of the existing ones. Change 
the spinner controls above the two numerical columns to see how this 
affects the way the numbers in the columns are displayed. You can 
also clear all of the data in the worksheet by clicking the “Clear All” 
button, and you can obtain information on how to print the worksheet 
by clicking the “Printing Info” button.

 After you have fi nished exploring the Diffi culty Index Worksheet, 
click the “Cancel” button to close the worksheet without changing the 
value in the Diffi culty Index data fi eld of the Activity Data Form. If 
you were to click the “Save” button, the weighted average value from 
the worksheet would be entered into the Diffi culty Index data fi eld for 
this activity. Instead we want that value to remain set at 1.0.
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 Timing of Activities. The TFF report clearly outlines the important 
issue of timing of the pre-harvest and harvesting activities (see Table 6 in 
the report). In that analysis the following assumptions were made:

• Three activities—“Block Layout & Line Clearing,” “Road Layout,” 
and “Log Deck Layout”—were assumed to begin 8 months (32 weeks) 
prior to harvesting. The latter two of these are carried out by the 
same personnel so they must be done in sequence. “Road Layout” 
will be done fi rst, followed by “Log Deck Layout.” On the other hand, 
“Block Layout & Line Clearing” and “Road Layout” can both begin 
at time 0, thus defi ning the start of the simulation. Neither of these 
two activities will have a preceding activity.

• Four activities—“Inventory,” “Vine Cutting,” “Road Construction,” 
and “Log Deck Construction”—were assumed to begin 7 months prior 
to harvesting, or 1 month (4 weeks) after the beginning of the simu-
lation. “Inventory” and “Vine Cutting” are done simultaneously and 
both logically follow “Block Layout & Line Clearing.” “Road Construc-
tion” and “Log Deck Construction” are done by a single construction 
crew and therefore must be done in sequence. Furthermore, “Road 
Construction” logically follows “Road Layout.”

• Two activities—“Data Processing” and “Mapmaking”—were assumed 
to begin 3 months prior to harvesting, during the rainy season when 
harvesting operations are shut down in that part of Brazil. These two 
activities are carried out in sequence. Thus “Data Processing,” the 
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fi rst of the two, will begin 4 months (16 weeks) after the beginning 
of “Inventory.” “Data Processing” logically follows “Inventory” in the 
chain of precedence because what’s being processing is information 
from the inventory.

• The remaining fi ve activities—“Tree Marking,” “Skidtrail Layout,” 
“Felling & Bucking,” “Skidding,” and “Log Deck Operations”—must 
be done sequentially. (Actually the last two operate simultaneously 
but skidding “precedes” log deck operations in a formal logical sense 
because at least one log must be skidded before anything can be 
done with it on the landing.) In the TFF study, tree marking was 
done immediately before skidtrail layout and can thus be considered 
the fi rst “harvesting” activity. Therefore it will begin 3 months (12 
weeks) after the beginning of “Data Processing.”

 All of these timing considerations can be summarized concisely in the 
following table:

Activity Preceded By Type
Begin 
Week

Block Layout & Line Clearing None 0 0

Road Layout None 0 0

Log Deck Layout Road Layout 1 --

Inventory Block Layout & Line Clearing 2 D = 4

Vine Cutting Block Layout & Line Clearing 2 D = 4

Road Construction Road Layout 2 D = 4

Log Deck Construction Road Construction 1 --

Data Processing Inventory 2 D = 16

Mapmaking Data Processing 1 --

Tree Marking Data Processing 2 D = 12

Skidtrail Layout Tree Marking 1 --

Felling & Bucking Skidtrail Layout 1 --

Skidding Felling & Bucking 1 --

Log Deck Operations Skidding 2 --

Notes: In the “Begin Week” column, ‘0’ indicates that the activity will begin 
at the beginning of week 0, the start of the simulation. ‘D’ (delay) indicates 
that the activity will begin the specifi ed number of weeks after its preceding 
activity has begun. The notation ‘--’ indicates that the beginning time for the 
activity will be calculated by RILSIM’s simulation engine.
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 The activities are listed in the table not in the order they appear in the 
RILSIM database but rather the order in which they will occur during 
the logging operation. The order in the RILSIM database follows the 
order in which the activities were presented in Appendix 3 of the TFF 
report, simply because that was an easy way to enter the data.

 You may be curious about the use of Precedence Type 2 coupled with 
startup delay times for fi ve of the activities in the table on the preceding 
page. Recall from Chapter 2 (page 40) that a Type 2 activity begins at 
the same time that its preceding activity begins, plus possibly a specifi ed 
delay time. The reason for using this type of precedence here is that 
under certain circumstances it can be used to guarantee a particular 
starting time for an activity while still recognizing the logical precedence 
relationship between the activity and the activity that precedes it.

 As an example, Activity B can be guaranteed a starting time that can 
be specifi ed in advance if the following conditions are met:

 • Activity B is preceded by Activity A
 • Activity B’s Precedence Type is 2 (see page 40)
 • Activity A has a known starting time
 • Activity B has a fi xed (known) delay time

 This result follows from the way the Type 2 precedence relationship is 
defi ned.

 If you study both the list of Type 2 activities and their preceding activi-
ties in the table on the preceding page, you should be able to convince 
yourself that with one exception, the Type 2 activities in the table will 
have starting times that can be specifi ed in advance. Type 0 activi-
ties by defi nition have known starting times. The starting times for 
the Type 0 and Type 2 activities will be as shown in the table below. 
These times are measured in weeks relative to the beginning time for 
the simulation (week 0).

Activity Starting Week

Block Layout & Line Clearing 0

Road Layout 0

Road Construction 4

Inventory 4

Vine Cutting 4

Data Processing 20

Tree Marking 32
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 The one Type 2 activity that’s missing from the above table is “Log Deck 
Operations.” This activity has been assigned Type 2 precedence because 
it should begin at the same time as skidding and its production rate 
is limited to that of the skidding operation. We’re not concerned about 
specifying the beginning time for log deck operations, however; we just 
want to ensure that it begins whenever skidding begins. We therefore 
give it a Type 2 precedence with no startup delay (although it could 
also be given a startup delay if that were appropriate; for instance, if 
we wanted to wait a few days for the log volume to build up before we 
begin loading the logs onto trucks).

 Why not use Type 0 precedence? Rather than using Precedence 
Type 2 together with delay times as shown in the table on page 95, an 
alternative (and conceptually simpler) way to specify the beginning 
time for an activity is to set its preceding activity to “None.” This will 
automatically change the Precedence Type to 0. Then you can either 
specify the desired beginning time directly, or you can set the beginning 
time to 0 and enter a delay that will provide the beginning time you 
want. You might want to try this later as an exercise to verify that 
you obtain the same results as when Type 2 precedence values are 
used. Although the method works properly, it suffers from a major 
disadvantage: The logical precedence relationships between activities 
are lost. You’ll see the loss of information immediately by comparing 
activity charts for the two methods. Thus, even though you get the 
same results by using Type 0 precedence values rather than Type 2, a 
signifi cant amount of information is lost from the model.

 Final Activity Review. Before leaving the activity dataset you should 
run through all of the activities and verify that the designated Preceding 
Activity and Precedence Type for each are correct and seem sensible 
to you. For an overview of the way all of the activities fi t together, you 
may want to examine the activity chart, which is shown at the top of 
the next page.

5. Scenario Data Form. The fi rst scenario we’ll run using the TFF RIL 
database is a simple one, as you’ll see when you open this data form 
(see the image at the bottom of the next page). The analysis will be 
based on total cost only, so the “Calculate Net Revenue” check box is 
cleared. To be consistent with the TFF study, we’ll set period 32 as the 
reference time for compounding and discounting. This is the beginning 
time for “Tree Marking,” which marks the beginning of the harvesting 
activities. In the TFF study, all costs that occurred prior to harvesting 
were compounded forward to that time. Harvesting costs were assumed 
to occur instantaneously at the reference time. Because RILSIM is able 
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to determine when each cost occurs and do the necessary compounding 
or discounting, we don’t have to make this simplifying assumption. As 
a result, however, the harvesting costs adjusted for the time value of 
money as determined by RILSIM won’t match exactly those reported 
in the TFF study. For some of the costs we’ll have to compare nominal 
amounts instead.

Network diagram 
for the activity da ta-
set in the TFF RIL 
example.
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6. Run the Scenario. Now execute the Run Scenario button to launch the 
simulation. RILSIM should report that the total simulated operating 
time is slightly more than 41.57 weeks, and that the nominal total 
cost is $13,323.70. The total cost adjusted for the time value of money 
is reported as $13,416.64. The fact that this total is greater than the 
nominal total indicates that the largest share of costs occurred prior 
to the reference time of week 32 and had to be compounded forwarded 
to that time period.

7. Simulation Report. Before we get to a comparison of results, you 
might want to print out the current simulation report. This will give 
you a written summary of the results that you can look at as we discuss 
comparisons in the next paragraph.

8. Comparing Results. The TFF report doesn’t summarize total costs in 
a way that is directly comparable with RILSIM’s results. Appendix 1 
in the TFF report lists costs and returns for the study, but these are 
reported in dollars per cubic meter of logs produced. To compare our 
results with those from the TFF study, therefore, we must prepare a 
similar report. This has been done in the table on the following page.

 As mentioned earlier, the TFF study team assumed that harvesting 
costs occurred instantaneously. RILSIM determines the beginning and 
ending time for each activity and therefore does not need to make this 
simplifying assumption. However, to compare with the TFF results 
we’ll have to use nominal costs for the three harvesting activities. 
This has been done in the table, as indicated in the footnote. Costs 
that occurred prior to harvest were compounded forward in the TFF 
study, and therefore we are able to compare the present values of costs 
for those activity groups.

 As you can tell from the table on the next page, RILSIM’s results com-
pare reasonably well with those from the TFF study. All of the small 
differences in the pre-harvest and harvest planning activities can be 
accounted for as simple rounding errors. The larger differences in the 
infrastructure and harvesting activities are due to a procedural error 
in the TFF study, in which the resale credit was double-counted. See 
page 90 for more information about this.

 It should be noted that the TFF study goes beyond RILSIM in that it 
includes costs associated with wasted wood, stumpage, training, and 
overhead (see Table 8 in the TFF report). We’ll consider overhead in 
the next step, but the other types of cost included in the TFF study are 
currently outside the scope of RILSIM’s capabilities.
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Comparison of reduced-impact logging costs as summarized in the TFF report 
with those calculated for the same conditions by RILSIM. The comparisons 
are for total costs per cubic meter of harvested timber.

9. Display a Gantt Chart. Now let’s look at some output from RILSIM 
that’s not available at all in the TFF report. On the Scenario Data Form, 
click the Gantt Chart button. The chart window will open and you 
should see an image similar to the one at the top of the opposite page. 
If you don’t recall exactly what a Gantt Chart is, review the description 

Activity Group / Activity

RILSIM Cost Results

RILSIM 
$/m3

TFF 
$/m3

Nominal 
Cost, $

Present 
Value of 
Cost, $

Pre-Harvest Activities†
 Block Layout & Line Clearing
 Inventory
 Vine Cutting
 Data Processing
 Mapmaking
 Totals

564.97
1,076.72

300.38
239.56
473.74

2,655.37

661.59
1,235.81

344.76
254.05
500.14

2,996.35

0.26
0.49
0.14
0.10
0.20
1.18

0.26
0.48
0.14
0.10
0.20
1.18

Harvest Planning Activities†
 Tree Marking
 Road Layout
 Log Deck Layout
 Totals

322.31
56.49
32.93

411.73

320.62
66.54
38.75

425.91

0.13
0.03
0.02
0.17

0.13
0.02
0.01
0.16

Infrastructure Activities†
 Road Construction
 Log Deck Construction
 Skidtrail Layout
 Totals

410.90
410.90
682.60

1,504.40

473.95
473.45
673.48

1,620.88

0.19
0.19
0.27
0.65

0.16
0.16
0.27
0.59

Harvesting Activities‡
 Felling & Bucking
 Skidding
 Log Deck Operations
 Totals

1,571.89
3,603.06
3,577.27
8,752.22

1,524.66
3,436.73
3,412.13
8,373.52

0.62
1.42
1.41
3.45

0.62
1.24
1.28
3.14

Grand Totals 13,323.70 13,416.64 5.25 5.07

†Present values of costs are compared for these activity groups.
‡Nominal costs are compared for the three harvesting activities.

Values in the TFF column (far right) are from Appendix 1 of the TFF report.

All costs per cubic meter are based on a 100-ha harvest of 2,536 m3.
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on pages 77-80 of Chapter 3. The chart as initially displayed should be 
satisfactory for viewing, but if you want to format it as shown above, 
do the following:

• Open the Page & Print Setup dialog window from the File menu 
or by clicking its toolbar button.

• Click the Print Setup button. In the print setup dialog window, 
choose Letter or A4 paper, then select Landscape mode. Click OK 
to return to the Page & Print Setup dialog window.

• In the Page & Print Setup dialog, set the “Gridline interval” to a 
value of 1. The units are weeks, corresponding to the simulation time 
period for this problem. All other values on the form can be left at 
their default settings (see the image below). Click the OK button to 
close the dialog window. The chart should now very closely resemble 
the image above, and if you send it to the printer, the chart will be 
formatted properly on the printed page.

RILSIM Gantt Chart
..............................Project TFF Logging Cost Study, Brazil (Holmes et al. 2000)

...........................Scenario Reduced-Impact Logging, Total Cost

Time, weeks
Activity Begin End 0 5 10 15 20 25 30 35 40
  7 Road Layout 0.00 0.18
  1 Block Layout & Line Clearing 0.00 2.40
  8 Log Deck Layout 0.18 0.29
  9 Road Construction 4.00 4.20
  2 Inventory 4.00 6.10
  3 Vine Cutting 4.00 6.10
10 Log Deck Construction 4.20 4.40
  4 Data Processing 20.00 20.46
  5 Mapmaking 20.46 21.72
  6 Tree Marking 32.00 33.02
11 Skidtrail Layout 33.02 35.15
12 Felling & Bucking 35.15 39.57
13 Skidding 39.57 41.57
14 Log Deck Operations 39.57 41.57

The setup window accessed from the 
File menu’s Page & Print Setup 
item or from the toolbar. The set tings 
shown here were used for the Gantt 
Chart at the top of this page. The 
values in the “Page margins” and 
“Column widths” data fi elds may 
be shown in millimeters rather than 
in inches, depending on the default 
setting for international units on 
your computer. The radio buttons at 
upper left allow you to switch between 
inches and millimeters.
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 In the Gantt Chart you can clearly see the four stages of the TFF log-
ging operation as outlined in the section entitled “Timing of Activities” 
beginning on page 94. A cluster of pre-harvesting activities begins at 
week 0, followed by a second cluster of activities beginning at week 4. 
The long break due to the rainy season is broken in the middle by two 
activities, “Data Processing” and “Mapmaking,” that can be carried out 
during rainy weather. Finally, the cluster of fi ve harvesting activities 
begins at week 32. The Gantt Chart also shows clearly that “Felling & 
Bucking” is the most time-consuming activity, requiring almost twice as 
much time as any of the remaining activities. All of this information is 
available from the formatted simulation report, but is generally much 
easier to understand when presented in graphical form.

10. Display a Bar Chart. The image below shows a bar chart summarizing 
the activity costs for the simulated operation. To create this chart, 
simply close the Gantt Chart and click the “Bar Chart” button on the 
Scenario Data Form. To format the chart as shown below, open the 
Page & Print Setup dialog window and set the “Gridline interval” 
to a value of 100. For this chart the axis units are US dollars. Also set 
both the maximum axis value and the “last label” setting to 3500. The 
page orientation should still be set on landscape mode. If not, you can 
click the “Print setup” button and set it.

 Note that although “Felling & Bucking” was the most time-consuming 
activity as shown in the Gantt Chart on the preceding page, it was far 
from the most costly activity—that distinction goes to “Skidding,” fol-
lowed closely by “Log Deck Operations.” Both of these activities involve 
signifi cantly greater equipment costs than those associated with felling. 
Even so, “Felling & Bucking” is the third most expensive activity, fol-
lowed by “Inventory.” In other logging operations these relationships 
may change signifi cantly. The TFF study involved areas with very little 
road construction, something that might differ on other areas.

RILSIM Bar Chart (Present Value of Activity Costs)
..............................Project TFF Logging Cost Study, Brazil (Holmes et al. 2000)

...........................Scenario Reduced-Impact Logging, Total Cost

Cost, $
Activity Present Value 0 500 1000 1500 2000 2500 3000 3500
  7 Road Layout 66.54
  1 Block Layout & Line Clearing 661.59
  8 Log Deck Layout 38.75
  9 Road Construction 473.95
  2 Inventory 1,235.81
  3 Vine Cutting 344.76
10 Log Deck Construction 473.45
  4 Data Processing 254.05
  5 Mapmaking 500.14
  6 Tree Marking 320.62
11 Skidtrail Layout 673.48
12 Felling & Bucking 1,524.66
13 Skidding 3,436.73
14 Log Deck Operations 3,412.13



103

Using RILSIM

11. Add a Support Activity. Almost any logging operation has one or more 
support activities. These are activities that do not produce outputs—at 
least not timber harvesting outputs—but that nevertheless provide 
essential services and, of course, inevitably incur costs. A support 
activity included in the TFF study involved the maintenance of a logging 
camp and related facilities, and the provision of services related to the 
encampment. This was also treated as a partial “overhead” (general 
cost) item because the logging supervisor’s cost was included in this 
support activity.

 Add a support activity for the logging camp to the RILSIM database 
as follows:

(a) Open the Activity Data Form and add a new record to the dataset. 
Give it a name such as “Camp Overhead.”

(b) Select “Support” from the drop-down list for the type of activity.

(c) The logging camp is operated only during the actual logging ac-
tivities. For our purposes these activities are “Felling & Bucking,” 
“Skidding,” and “Log Deck Operations.” Therefore, as the preceding 
activity select the fi rst of these, “Felling & Bucking.”

(d) For the type of precedence, select Type 6. This will cause the support 
activity, Camp Overhead, to begin when Felling & Bucking begins 
and to end when the fi nal activity of the entire logging operation 
has been completed.

(e) Accounting for the costs of a support activity can be done in any 
number of ways. We cannot duplicate exactly the method used in 
the TFF report because the accounting for that study was done on 
a piece-rate basis. The current version of RILSIM does not enable 
you to charge support activities using piece rates; instead you must 
use hourly costs.

 Because a logging camp must be maintained all day long, every day 
of the week, we’ll compute its costs based on a 24-hour day and a 
7-day week. Thus, enter 168 (calculated as 24  7) in the edit fi eld 
provided for Operating Hours per Week.

(f) We’ll assume that the logging camp starts operation at exactly 
the same time as Felling & Bucking. Therefore, leave the Startup 
Delay data fi eld set at its default value of 0. As an aside, it’s worth 
noting that this data fi eld could logically have a negative value in 
some circumstances. Suppose, for instance, that we wanted Camp 
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Overhead to begin one week prior to Felling & Bucking. We could 
ensure this by entering –1 as the Startup Delay for Camp Over-
head.

(g) Next, to make the personnel assignments for this activity, execute 
the Personnel button. For the fi rst assignment, choose “Supervi-
sor” from the drop-down list. Then, in the “Number Assigned” edit 
fi eld, enter 0.238. This assignment value is based on the assump-
tion that the supervisor will be paid for 40 hours work each week. 
If you divide 40 paid hours per week by 168 camp operating hours 
per week, the result is 0.238. Think of this fraction as expressing 
the idea that the supervisor’s wage is based on 23.8% of the camp 
operating hours per week. Click the Update Record button.

(h) Add a new personnel assignment record. Choose “Cook” from the list 
and again enter 0.238 in the data fi eld. Click Update Record.

(i) Add a third personnel assignment record and choose “Driver” from 
the list. Again enter 0.238 in the data fi eld. Click Update Record, 
and then click Return.

(j) To make equipment assignments for the activity, execute the Equip-
ment button. For the fi rst assignment, choose “Camp Facilities” 
from the list. In the data fi eld enter 1, then click Update Record. 
An assignment of 1 is used because the cost of constructing the camp 
and providing items such as tents and related equipment has been 
based on the total number of hours in a harvesting season. In Ap-
pendix 7 of the TFF report, the total cost of this item per harvesting 
season is shown as $351. The RIL harvesting season is 8 months, in 
which there are a total of 5760 hours (8 months  30 days/month  
24 hours/day). Dividing $351 by 5760 hours gives $0.06/hr, the cost 
in the equipment data record for the “Camp Facilities” equipment 
item.

(k) Add a new equipment assignment record. Choose “Camp Genera-
tor” from the list. In this case, enter 0.167 into the data fi eld and 
then click Update Record. The fraction 0.167 is based on the as-
sumption, documented in Appendix 7 of the TFF report, that the 
generator is operated 28 hours per week (4 hours per day, 7 days 
per week). Dividing 28 by 168 gives 0.167.

(l) Add a third equipment assignment record and choose “Pickup 
Truck” from the list. Enter 0.2038 in the data fi eld. This number 
is derived as follows: In Appendix 7 of the TFF report, it is noted 
that the pickup truck is used for 1200 hours during the 8-month 
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harvesting season. The total number of potential hours the pickup 
truck could be used in 8 months is 5760 (see item j on the preceding 
page). Then, dividing the actual usage by the potential usage, we 
obtain 1200 / 5760 = 0.2083.

 After clicking Update Record, execute the Return button to return 
to the Activity Data Form. You should verify that the Activity Unit 
Cost data fi eld now shows an amount of $4.02 per operating hour. 
Because the Camp Overhead activity “operates” 168 hours per week, 
this support activity will cost $4.02/hr  168 hrs = $675.36 per week. 
This total weekly support cost includes the personnel costs for the 
Supervisor, Cook, and Driver, and the equipment costs for the Camp 
Facilities, Camp Generator, and Pickup Truck. The image below shows 
the completed activity data record for the support activity.

12. Save the Revised Database

 Now that you’ve extended the original analysis, it’s a good idea to 
save the revised data fi le under a new name. Pull down the File menu 
and choose the Save As command. Enter a new fi lename such as 
“TFF RIL+Overhead.rdb.” RILSIM will confi rm that the fi le has been 
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saved under the new name by displaying a message in the status bar 
for a few seconds. You’ll also note that the fi lename in RILSIM’s title 
bar has changed to the new name.

13. Revise the Scenario. Open the Scenario Data Form. In the space for 
the scenario description add the notation “including Camp Overhead.” 
Then press Update Data and click the Save button on the toolbar to 
incorporate this change into your database.

14. Run the Simulation. Execute the Run Scenario button. RILSIM will 
report that the simulated operating time is the same as in the previous 
run, slightly more than 41.57 weeks. The total cost fi gures, however, have 
now increased to $17,658.14 for nominal total cost and $17,599.07 for 
discounted total cost. If you print the summary report or look at it using 
Print Preview, you’ll notice that all items in the report are identical to 
those in the previous report (Step 7 on page 99) except that the activity 
“Camp Overhead” has been added just below “Felling & Bucking.” It 
begins at the same time as Felling & Bucking and ends when the fi nal 
activity (Log Deck Operations) has been completed. Its nominal cost 
is reported as $4,334.44 and its discounted cost as $4,182.43. If you 
subtract these costs from the respective total costs, you’ll obtain the 
same total costs as reported for the previous simulation.

15. Comparing Results. It’s not possible to compare the results for this 
support activity in any meaningful way with the results for the equivalent 
support activity reported in the TFF study. Appendix 7 of the TFF 
study provides details of the methodology that was used in that study, 
but there are several calculation errors in the table and at least one 
derivation error. Rather than attempt a detailed comparison, therefore, 
we simply observe that it is essential to include support activities in 
your analysis when they add substantially to the total cost. This is 
clearly true for this example—the Camp Overhead support activity 
has increased the total cost by about one-third. If you now display a 
bar chart you’ll see that it is the most expensive single activity.

16. Analyze Net Revenue. In Section 3.1 of TFF study, an average log 
price of $25.50/m3 was used to compute net revenues. Let’s now add 
this capability to our RILSIM model. We’ll also change the reference 
time for interest calculations so that it corresponds to the initial point 
at which revenues are generated. This is the reference point commonly 
used in fi nancial analyses of this type.

(a) Open the Scenario Data Form. Change the scenario description to 
something like “Reduced-Impact Logging, Net Revenue (including 
Camp Overhead).”
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(b) Click the “Calculate Net Revenue from Log Production” check 
box. This will enable the drop-down list and edit fi eld in that data 
block. From the drop-down list, select “Log Deck Operations” as 
the revenue-producing activity. The assumption implicit in this 
selection is that logs are sold from the log deck. Enter a log price 
of 25.50 into the edit fi eld.

(c) In the Compounding and Discounting data block, select the “To 
Beginning of Activity” radio button. This will enable the drop-down 
list. Again, select “Log Deck Operations.” Time accounting will now 
be done with the beginning of this activity as the reference point.

(d) Click Update Data, then choose Save As from the File menu and give 
your database a new name such as “TFF RIL Net Revenue.rdb.”

17. Run the Simulation. Click the Run Scenario button. RILSIM reports 
the following:

• The projected operating time is slightly more than 41.57 weeks, as 
in the previous two runs.

• Total costs are as follows:

  Nominal $17,658.14
  Compounded $18,307.13

 Note that although the nominal total cost is the same as in the 
previous simulation report, the compounded amount is signifi cantly 
more than in the previous report. This is due to the fact that we have 
changed the reference time for compounding and discounting. Previ-
ously the reference time was at week 32. Now it’s at the beginning 
of Log Deck Operations. This activity begins at week 39.57, so the 
reference time for interest calculations has been moved almost 7.6 
weeks later than in the previous simulation report. At an annual 
interest rate of 27.4% this change has a signifi cant effect on the time 
value of money.

• Net revenues are reported as follows:

  Nominal $47,009.86
  Discounted $45,857.25

• If you print a simulation report or examine it with Print Preview, 
you’ll note that two new rows have been added at the bottom of the 
report to show the total and net revenues.
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Conventional Logging Analysis
Although the analysis of reduced-impact logging described above can be 
useful on its own, it is always helpful to provide an alternative against 
which comparisons can be made. We now turn to the conventional logging 
alternative as reported in the TFF study.

Our comparison of these two alternatives is less complete than the analysis 
included in the TFF study, for the reason that RILSIM’s capabilities are 
limited only to direct fi nancial analysis. We are not able to include costs 
associated with wasted wood, stumpage cost, or training activities—these 
have to be analyzed outside of RILSIM.

1. Open the CL Database. If the database from the RIL analysis is still 
open, close it. Then open the fi le in your RILSIM Data\Samples folder 
named TFF CL.rdb. This is the database for the conventional logging 
analysis as reported in the TFF study.

2. General Data Form. When this form appears you’ll note that all of 
the data on the form are identical to those for the RIL analysis.

3. Wage Data Form. Data have been entered for eight personnel categories. 
All of these have similar names as in the RIL analysis. Some of the 
costs differ slightly, for reasons that are discussed in Appendix 5 of the 
TFF report.

4. Equipment Data Form. Information has been provided for 12 
equipment items. For the most part these items are identical to the 
equivalent items used in the RIL analysis, and the costs are the same. 
One difference is that a bulldozer was used as the skidding machine 
for conventional logging, rather than the rubber-tired skidder that 
was used on the RIL operation. Equipment costs can be verifi ed by 
comparing data presented in Appendix 6 of the TFF report.

5. Activity Data Form. Seven activities have been defi ned. Costs for 
six of these can be verifi ed by comparison with Appendix 2 of the TFF 
report. The seventh, “Camp Overhead,” is described below. To verify 
the personnel and equipment assignments, see the footnotes associated 
with Appendix 2 of the TFF report.

(a) Activity 7, “Camp Overhead,” is a support activity correspond-
ing to the activity of the same name in the RIL analysis. Basic 
information was taken from Appendix 7 of the TFF report. This 
support activity differs from the corresponding activity for the RIL 
analysis in two ways: (1) The potential number of hours during the 
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harvesting season is 5040. This is because the harvesting season 
for conventional logging is only 7 months. (2) No driver is assigned 
to the pickup truck. In conventional logging the pickup truck was 
operated by the supervisor.

 This support activity begins at the same time as “Tree Hunting,” 
and ends when the fi nal activity is completed.

(b) The start of the simulation is defi ned by activity 2, “Road Construc-
tion.” According to the TFF report, this activity was carried out 7 
months (28 weeks) prior to the start of the harvesting operation. 
It was then followed by “Log Deck Construction.”

(c) The fi rst harvesting operation is “Tree Hunting.” This activity be-
gins 28 weeks after the beginning of “Road Construction.” Hence, 
Precedence Type 2 is used to guarantee a specifi ed beginning time 
for the activity, as was done in the RIL analysis (see the discussion 
beginning on page 96 for details).

(d) The remaining harvesting activities follow “Tree Hunting.” “Felling 
& Bucking” begins at the same time as “Tree Hunting” and thus 
has Type 2 precedence. “Skidding” follows, with Type 1 precedence. 
“Log Deck Operations” begins at the same time as “Skidding” and 
thus has Type 2 precedence.

(e) Production rates for the activities are taken from the summary in 
Appendix 3 of the TFF report. For activities with production rates 
in m3/hr, the “Production/ha” value of 25.36 m3/ha is the same 
as for the RIL analysis. This is the average volume harvested per 
hectare for both the RIL and CL analyses in the TFF study.

6. Scenario Data Form. The initial scenario is for a cost-only analysis, 
with the reference time for interest calculations set at period 28 (i.e., 
28 weeks after the beginning of the simulation).

7. Run the Simulation. Click the Run Scenario button. RILSIM reports 
that the projected operating time is slightly more than 34.86 weeks 
and total costs are as follows:

  Nominal $18,389.41
  Compounded $18,196.32

 By comparison with the cost results for the RIL analysis (see item 14 
on page 106), these fi gures indicate that the conventional logging costs 
are 4.1% and 3.4% higher, respectively. This confi rms the conclusion in 
the TFF report that conventional logging is no cheaper than reduced-
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impact logging, at least under the conditions of this study. If we were 
able to include the costs of wasted wood, stumpage, and training, the 
signifi cant cost advantage of reduced-impact logging would in fact 
become clearly evident. You may want to read carefully the discussion 
in Section 4 of the TFF report where these issues are examined.

8. Analyze Net Revenue. As a fi nal exercise, return now to the Scenario 
Data Form and revise it to accommodate the analysis of net revenue. 
Change the scenario description to something like “Conventional 
Logging, Net Revenue.” In the net revenue data block, select “Log Deck 
Operations” as the revenue-producing activity and enter a log price of 
$25.50/m3. In the compounding and discounting data block, set the 
reference time to the beginning of “Log Deck Operations.” Then save 
the fi le under a new name such as “TFF CL Net Revenue.rdb.”

 Now press the Run Scenario button. You should obtain the following 
results:

Item Nominal Value ($) Present Value ($)

Total revenue 64,668.00 64,026.25

Total cost 18,389.41 18,582.49

Net revenue 46,278.59 45,443.75

 The total cost and net revenue results can be compared directly to 
the results from the RIL analysis as summarized in point 17 on page 
107. The discounted net revenue for CL is about 0.9% lower than the 
discounted net revenue for RIL, largely due to differences in the time 
value of money and the fact that the CL operation requires a shorter 
total time (even though its total cost is higher). Again, these fi gures 
do not include the substantial savings that can be expected in a RIL 
operation due to reduced wood waste and reduced stumpage cost.

9. Compare the Charts. You may fi nd it instructive to compare the 
Gantt Chart and Bar Chart for the CL operation with those for RIL. 
We leave this to you as an individual exercise.

The End
This concludes our detailed examination of the TFF example problem and 
our exploration of RILSIM’s capabilities for analyzing and comparing log-
ging simulations.
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A n important feature of RILSIM is its ability to perform detailed 
time accounting. For each activity in the RILSIM model of a log-
ging operation, the simulation engine calculates the beginning 
and ending times and the production quantity, if any, resulting 

from the activity. This allows it to determine the costs associated with the 
activity based on hourly or piece-rate unit costs, or a combination of the 
two. The total activity cost is then adjusted as necessary to account for 
the time value of money. RILSIM can similarly adjust revenues received 
from a revenue-producing activity.

Adjustments related to the time value of money are referred to as “com-
pounding” if the costs or revenues occur prior to some reference time point. 
They are referred to as “discounting” if the costs or revenues occur after the 
reference time point. Compounded amounts are greater than the nominal 
amounts upon which they are based, and discounted amounts are less than 
the nominal amounts from which they have been derived.

The summary in this appendix provides a very brief overview of the way 
RILSIM’s time accounting operates. If you don’t have a thorough background 
in interest calculations, one of the more comprehensive treatments of the 
topic in a forestry context is provided in the book Forest Resource Economics 
and Finance by W. David Klemperer (published in 1996 by McGraw-Hill, 
Inc. under ISBN 0-07-035122-8). The discussion in this appendix is related 
especially to Klemperer’s Chapter 4, “The Forest as Capital”. Klemperer’s 
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treatment of the topic is much more complete than what is provided here. 
He does not derive the specifi c formulas used by RILSIM but his explana-
tions greatly facilitated those derivations.

In the simplest case, that of annual time accounting, the relationship be-
tween a cost or revenue that occurs at time 0 and the compounded value 
of that cost or revenue N years later can be expressed as follows:

where:

 VN = the compounded (future) value at the beginning of year N

 V0 = the cost or revenue that occurred at time 0

 r = the annual interest rate expressed as a decimal fraction (e.g., 
if the annual interest rate is 15%, then r = 0.15).

The inverse of Equation (1) may be used to calculate the present value 
(discounted value) of a single amount available N years in the future. This 
equation may be written as follows:

The time-accounting procedures used in RILSIM are based upon the simple 
relationships in Equations (1) and (2), but are somewhat more complex 
than these. This is because:

• RILSIM permits interest to be compounded at frequencies other than 
one year. In a RILSIM model, interest may be compounded annually, 
monthly, weekly, or daily.

• The simulation time unit used in a RILSIM model is not limited to 
one year. In fact, that’s not even an option. The reason for this is that 
RILSIM models involve activities that usually have durations ranging 
between a few days and a few months. The choices offered by RILSIM 
for the simulation time unit are one day, one week, or one month.

(1) N
N rVV )1(0

(2)
 

N
N

r
V

V
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• Costs and revenues do not occur all at once in a RILSIM model but 
rather are spread over the duration of the activity. RILSIM assumes 
that the costs or revenues associated with an activity occur at regular 
intervals during the activity. These regular intervals are equal to the 
simulation time unit for the RILSIM model.

As an example to illustrate the fi nal point above, consider an activity that 
starts at period 4.3 and ends at period 9.7. Assume for simplicity that the 
total cost of the activity is $540. RILSIM would then calculate the cost per 
simulation time period as 540 / (9.7 – 4.3) = $100/period. It would further 
assume that this periodic activity cost would occur at regular intervals 
starting at the beginning time period of the activity and occurring at in-
tervals of one period thereafter:

t = 4.3 $100

t = 5.3 100

t = 6.3 100

t = 7.3 100

t = 8.3 100

t = 9.3 40

Total $540

In fi nancial analysis terminology, a series like the one above is referred to 
as a “terminating periodic series.” Such series have been widely studied 
in forest economics because they represent reasonable approximations for 
many types of forestry investments.

For the situation modeled by RILSIM, Equation (3) on the following page 
can be used to compute the future (compounded) value of a terminating 
periodic series of costs or revenues. Equation (4) is the related formula that 
can be used to calculate the present (discounted) value of a terminating 
periodic series. Although these formulas appear rather imposing, in fact 
they are relatively easy to implement in computer code and can be made 
to operate very effi ciently.
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The following variables are defi ned for both Equations (3) and (4):

 VN = future (compounded) value of the series of costs after N time 
periods of length dt.

 VN–tr+tb
 = present (discounted) value of the series of costs if the series 

begins at time period tb, terminates after N time periods, each 
of length dt, and is being discounted to the reference time 
period tr.

 dt = duration of a simulation time period (e.g., one week). Also 
referred to as the “simulation time unit”. In RILSIM this can 
be one day, one week, or one month.

 t = beginning of a time period of length dt. Unless specifi ed oth-
erwise by the user, a simulation always begins at t = 0.

 tr = reference time period to which costs and revenues are com-
pounded or discounted.

 tb = beginning time period for an individual activity.

 C = cost incurred or revenue received during each period dt.

(4)
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 N = number of time periods of length dt during which the cost or 
revenue C occurs.

 r = nominal annual interest rate, expressed as a decimal fraction 
(e.g., a 5% annual interest rate is written as 0.05).

 m = number of discounting or compounding periods per year. In a 
RILSIM model this may be 1, 12, 52, or 365, corresponding to 
annual, monthly, weekly, or daily compounding.

 r/m = effective interest rate per compounding or discounting pe-
riod.

 w = number of dt periods per year (e.g., if dt represents one week, 
then w = 52).

 m/w = discounting or compounding interval between periodic costs; 
i.e., the number of discounting or compounding periods per 
time period of length dt.

 N–tr+tb = number of time periods of length dt during which the costs are 
to be compounded or discounted.
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Understanding precedence relationships is an important part 
of simulation modeling. In a RILSIM model, precedence rela-
tionships must be specifi ed correctly to ensure that the model 
will serve as an adequate representation of reality. The set of 

precedence relationships among activities forms a chain that determines 
when each activity will be executed and also defi nes the nature of the 
interactions among activities.

In RILSIM, if a logical precedence relationship exists in which Activity B 
is preceded by Activity A, then B cannot process an area of forest until the 
same area of forest has been processed by A.

To facilitate its treatment of precedence relationships, RILSIM translates 
all production rates into equivalent rates that are expressed in terms of 
the area of forest processed per operating hour. For instance, if an activity 
produces cubic meters of logs at a certain hourly rate, a conversion factor 
(the production per unit area, in this case measured in cubic meters of logs 
per unit area of forest) is used to determine the equivalent area of forest 
processed per hour by the activity. Suppose the activity produces logs at 
the rate of 20 m3/hr. If on the average, 16 m3 of logs are processed from 
each hectare of forest, then an equivalent area-based production rate may 
be calculated as

20 m3/hr
= 1.25 ha/hr

16 m3/ha
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Precedence Types
In the diagrams that follow,

• Activity B is preceded by Activity A and a Precedence Type is being 
assigned to Activity B.

• D represents the startup delay time for Activity B. It may be 0.

• RateA and RateB are the production rates for Activity A and Activity 
B respectively, expressed in terms of the area of forest processed per 
operating hour of the respective activity.

Type 0 Precedence

 No precedence relationship exists between A and B. The two activi-
ties therefore proceed independently. The default beginning time for 
an activity with this type of precedence is time 0, but a different time 
may be set if desired. If a support activity has this type of precedence, 
its ending time must also be specifi ed.

Type 1 Precedence

 Activity B can begin when Activity A ends.

 Because Activity A will have been completed when Activity B begins, 
B will proceed at its full production rate.

 If Activity B is a support activity, its ending time must be specifi ed. 
If it is a normal activity, the ending time will be calculated from the 
production rate.

D

Activity A

Activity B
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Precedence Relationships

Type 2 Precedence

 Activity B can begin when Activity A begins.

 If Activity B is a support activity, its ending time must be specifi ed. 
If it is a normal activity, the ending time will be calculated using the 
relationships below.

(a) If RateB  RateA or if B is a support activity, Activity B is not re-
stricted by the production rate of A and therefore proceeds at its 
full production rate.

(b) If RateB > RateA, Activity B is limited to the production rate of 
Activity A until A has ended. After that, Activity B proceeds at its 
full production rate.

Type 3 Precedence

 Activity B cannot end until Activity A ends.

 If Activity B is a support activity, its beginning time must be specifi ed. 
If it is a normal activity, the beginning time will be calculated using 
the relationships below.

(a) RateB > RateA. In this situation, Activity B will have a shorter 
duration than Activity A. Thus, Activity B will end at the ending 
time of Activity A plus any delay time that has been specifi ed. The 
beginning time of Activity B can be calculated with the following 
equation:

 BBegin = AEnd + D – [(Area of Forest to be Processed) / RateB]

D

Activity A

Activity B

Activity A

D Activity B
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(b) RateB  RateA. In this case, Activity B will have a longer duration 
than Activity A. Thus, Activity B will begin at ABegin + D and will end 
sometime after AEnd. The actual ending time depends on RateB.

Type 4 Precedence

 This type of precedence may be assigned only to support activities. 
It is the same as Type 0 but ends only after all other activities have 
ended.

 The default beginning time for an activity with this type of precedence 
is time 0, but a different time may be set if desired. The activity will 
end when the fi nal activity in the simulation ends.

Type 5 Precedence

 This type of precedence may be assigned only to support activities. 
It is the same as Type 1 but ends only after all other activities have 
ended.

 Activity B can begin when Activity A ends, plus a possible delay time. 
Activity B will end when the fi nal activity in the simulation ends.

Type 6 Precedence

 This type of precedence may be assigned only to support activities. 
It is the same as Type 2 but ends only after all other activities have 
ended.

 Activity B can begin when Activity A begins, plus a possible delay time. 
Activity B will end when the fi nal activity in the simulation ends.

Activity A

D Activity B
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